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PREFACE
Information and Communication Technology (ICT) is so important in the world today that it makes it 
imperative for every person to be competent in the use of ICT for the many tasks that one will have 
to accomplish. This book is written to provide the basic skills in ICT for Grade 9 students of Federal 
Democratic Republic of Ethiopia. It is expected that the knowledge and skills gained through this book 
will help the students to use ICT in almost all their courses at school. The book covers selected basic 
topics in ICT which offer hands-on activities to help students in acquiring the required ICT skills.
	 The key features of this book will help the students to:
	 l	 understand the development of computers and communication technology.
	 l	 develop interest and use ICT for learning in other subjects.
	 l	 understand  information and computer security
	 l	 acquire the knowledge for application of ICT in word processing, presentation and spreadsheet 

application.
	 l	 use the Internet to communicate effectively.
	 l	 access and share information through the Internet.
	 l	 follow basic ethics in the use of ICT.
	 l	 learn LOGO language.
	 The text has been designed in a simple and user friendly way. This text focuses on the fundamentals 
of ICT, which change slowly. This not only makes the information remain useful to a student when 
one graduates, but also makes the student focus on the foundation concepts on ICT. This book also 
illustrates the latest developments in the rapidly changing world of ICT. Review questions have also 
been given at the end of each unit.
	 Suggestions for the improvement of this book will be gratefully acknowledged.

Authors
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Introduction  
to ICT

   Unit Outcome
	 Students will be able to:

	 	 know the term data, information, technology and the sources of information;

	 	 understand the differences between computers of one generation from the other;

	 	 recognize the types of computers used today and their difference;

	 	 understand the computer system.

1.1 Overview of ICT

Information and Communication Technology (ICT) refers to technology that provides access to information 
through telecommunications (the transmission of signals over long distances). It focuses primarily 
on communication technologies. This includes the Internet, wireless networks, cell phones, and other 
communication media.
	 Information and Communication Technologies (ICTs) have become a major factor in social and economic 
development of the society. The advances in technology 
and reductions in costs have made ICTs suitable for less 
developed countries. ICTs are no longer luxury for the elite, 
but becoming absolute necessity for those in rural areas. 
Therefore, Ethiopia is not leaving ICTs as a sector for just 
commercial interests or free market and privatization, but 
rather regards them as part of the general public welfare, 
participation, use and debate.
	 The ability to participate in ICTs requires participation, 
partnership, understanding of social implication of new 
technologies and management of changes at national 
level. The immediate potential benefits of ICTs in Ethiopia 
include:
	 1.	 Efficient communications for manufacturing, service and tourism sector.
	 2.	 Fast response to natural disasters and effective rural health and family planning services.
	 3.	 Effective governance and administrative effectiveness.
	 4.	 Efficient education, research and communication of research results.
	 5.	 Access to global market and research information.

Unit 1   

Fig. 1.1: Use of ICT for the general public welfare
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	 6.	 Employment opportunities for small and medium enterprises.
	 7.	 Effective and enhanced data and information gathering and distribution for better planning.
	 8.	 Enhanced national cohesion and integration of heterogeneous social composition or geographical 

dispersal.
	 Government, individuals and institutions should work hard in improving the use of ICTs in 
Ethiopia.

Basic Terms Related to ICT

	 Let us have an overview of the basic terms related to ICT: 

l	D ata vs Information
The frequency of the use of the words data and information are very high in our daily lives. Depending 
on the context, the meanings and use of these words differ. Both data and information are types of 
knowledge or something used to attain knowledge. Though used interchangeably, there are many 
differences between the meanings of these two words.

	 Data is a collection of raw facts and figures or a raw input which when processed or arranged makes meaningful 
output. Data is the plural of the Latin word “datum”. For example, students fill an admission form when 
they get admission in school/college. The form consists of raw facts about the students. These raw facts 
are student’s name, father name, mother name, address, etc. The purpose of collection of this data is 
to maintain the records of the students during their study period in the school/college.

	 In computer terms, symbols, characters, images, or numbers are data. These are the inputs for the 
system to give a meaningful interpretation.

	Users need data to create useful information.

	 Information is the data that is organized, meaningful and useful for 
making a decision. Computers process data to create information, 
such as the total marks for each student, which are used to decide 
who is the topper.
	 Data collected from census is used to generate different types of 
information. The Ethiopian government can use it to determine the 
literacy rate in the country. Government can use the information in 
making important decisions such as to improve literacy rate and 
implement ICTs etc.
	 Data processing is the transformation of data into meaningful 
information.

The whole purpose of a computer (and communications) system is to produce (and transmit) usable 
information.

	 Figure 1.3 illustrates the processing of raw data into useful information, its recycling and its packaging 
in a new form so that it is easier to understand, more attractive, or more useful.

Fig. 1.2: Census Information can be very 
useful for Implementing ICTs in Ethiopia
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Fig. 1.3: Data versus Information

	 Data processing includes the following steps:
	 (i)	 Data Coding	 (ii)	 Data Input,
	 (iii)	 Data Editing, and	 (iv)	 Data Manipulation.
	 Table 1.1 gives the differences between data and information.

Table 1.1: Differences between Data and Information

Data Information

It is a collection of facts and figures. It is a collection of final results.

It is in an unorganized (raw) form. It is in an organized form.

It is not in directly useful form. It is in directly useful form.

It needs processing. It does not need any processing.

It is also termed as input. It is also termed as output.

It requires observations and recordings. It requires analysis.

l	T echnology
Technology is the usage and knowledge of tools, crafts, techniques, or systems, or methods of organizations. 
Science is concerned with how and why things happen. Technology focuses on making things happen. 
Technology began to influence human beings as soon as people began using tools.
	 Now-a-days, technology is an integrated part of lives of human beings. For example, the technology 
in communications such as mobile phones help us to connect with the other people easily.
	 Technology has a simple but important role in our life now-a-days. Without it, we will not be 
having the connection with the other people.

l	 Information Technology
“Information Technology”, or “IT”, refers to anything related to computing technology, such as networking, 
hardware, software, the Internet, or the people that work with these technologies.

or
	 Information Technology is the study, design, development, implementation support and/or management of any 
computer based information systems. This relates particularly to software applications and computer hardware.
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	 The history of IT goes back several years. In order 
to perform the functions associated with the field of 
technology, the modern field uses computers, servers, 
database management systems and cryptography.
	 Since we live in the “information age”, information 
technology has become a part of our everyday lives. That 
means the term “IT”, already highly overused, is here to 
stay.

l	 Sources of Information
An information ‘source’ can be categorized by the type of information it contains.   Sources are usually 
classified as primary, secondary and tertiary. Table 1.2 illustrates the various sources of information.

Table 1.2: Sources of Information

Primary Sources Secondary Sources Tertiary Sources

Original ideas and research Analysis, discussion or 
interpretation of original 
ideas and research 

Significant knowledge is 
combined, condensed and 
summarized 

Examples:
Research articles, research 
reports, diaries, letters, 
performance recordings, 
standards, legislation.

Examples:
Review articles, specialist texts, 
textbooks, newspaper articles.

Examples:
Encyclopedias, handbooks, 
dictionaries, bibliographies.

                 
	 The use of information sources is influenced by the following factors:
	 (i)	 subject of the study, 
	 (ii)	 nature of the information sought,
	 (iii)	 the attitude of the user,
	 (iv)	 the intensity of the need one feels, and
	 (v)	 working conditions.

Documentary Sources
As mentioned earlier the sources of information or evidence are often categorized as primary, secondary, 
or tertiary material. These classifications are based on the originality of the material and the proximity 
of the source or origin. This informs the reader as to whether the author is reporting information that 
is first hand or is conveying the experiences and opinions of others which is considered second hand. 
Determining if a source is primary, secondary, or tertiary can be tricky. Let us describe the three 
categories of information and give examples to help you make a determination.   

Primary Documentary
Primary sources  of information are  original materials  that often convey new ideas, discoveries, or 
information. These sources originate from the time period under study. Examples of primary sources 
include:

Fig. 1.4: Information Technology has become a part 
of our daily lives (Courtesy: web.worldbank.org)

Fig. 1.5: Use of Information Sources is 
Influenced by the Working Conditions
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	 (i)	 original research studies (often in the form of journal articles in peer-reviewed publications), also 
called empirical studies (e.g., psychology)

	 (ii)	 patents, technical reports
	 (iii)	 original documents such as diaries, letters, e-mails, manuscripts, lab data/notes
	 (iv)	 newspaper articles from the time period under study
	 (v)	 autobiographies, first-person accounts, case studies
	 (vi)	 artifacts and archival material such as official documents, minutes recorded by government agencies 

and organizations, photographs, coins, fossils, natural specimens
	 (vii)	 works of art such as literature, music, architecture, or paintings.

Secondary Documentary
Secondary sources  of information are  based on primary sources. They are 
generally written at a later date and provide some discussion, analysis, 
or interpretation of the original primary source. Examples of secondary 
sources include:
	 (i)	 review articles or analyses of research studies about the same topic 

(also often in peer-reviewed publications)
	 (ii)	 analyses of original documents or archival material
	 (iii)	 biographies, reviews, or critiques of an author.

Tertiary Documentary
Tertiary sources of information are based on a collection of primary and secondary sources. Examples of tertiary 
sources include:
	 (i)	 textbooks (sometimes considered as secondary sources)
	 (ii)	 dictionaries and encyclopedias 
	 (iii)	 manuals, guidebooks, directories, almanacs
	 (iv)	 indexes and bibliographies.

How do you tell the difference?
It is not always easy to distinguish primary and secondary sources.   The distinction between primary, 
secondary, and tertiary sources can differ between subjects and disciplines, particularly between the 
sciences and the humanities. 
	 (i)	 In the sciences, research findings may be communicated informally through e-mail, then presented 

at meetings before being formally published as a primary source.   Once published, they will be 
commented on by other scholars (secondary sources) and professionally indexed in a database or 
printed index (tertiary sources).  

	 (ii)	 In the humanities, primary sources for the cultural history of the 1950s might include the paintings, 
novels, and films of the period.

	 (iii)	 A newspaper article is a primary source if it is reporting the news or the views of the day, but may 
be a secondary source to the extent that it includes analysis and research based on other sources.

If a source does not fit the description of a primary source, it is most likely a secondary source.

Fig. 1.6: A biography—One of the 
Secondary Documentary Sources of 

Information



Unit – 1 Introduction to ICT

6	  	 Information Communication Technology — Grade 9 Student Textbook

 Tip:  Work Backwards 

	 1.	 Start with tertiary sources (reference sources, databases, etc.)
	 Find background information on your topic by consulting reference sources and web pages for introductions 
and summaries, and to find bibliographies or citations for secondary and primary sources.
	 2.	 Then go to secondary sources
	 Find articles, books, webpages, and other sources providing more extensive and in-depth analysis of a 
topic. Check to see what other scholars and experts have to say about your topic.

	 3.	 Then try primary sources

	 Once you have some background knowledge on your topic, you will be better able to understand, 
interpret, and analyze the primary source of information. See if you can find primary source evidence to 
support or refute what other scholars and experts have said about your topic, or try an interpretation of 
your own and look for more primary sources to confirm or refute your thesis. When you present your 
conclusions, you will have produced another secondary source to assist others in their research.

Non-documentary Sources
The non-documentary sources are also called Informal Information Sources. These include government 
departments, research organizations, learned professional societies, industries, universities, colleagues, 
corridor meetings at conferences and social gatherings.
	 Some examples of institutes which are excellent non-documentary sources in Ethiopia are given below 
along with their URLs (Uniform Resource Locators).
	 (i)	 Addis Ababa University (URL: www.abyssiniacybergateway.net/ethiopia/)
	 (ii)	 Alemaya University (URL: www.alemayau.edu.et/)
	 (iii)	 Institute of Ethiopian Studies (URL: www.ies-ethiopia.org)
	 (iv)	 International Community School of Addis Ababa (URL: www.icsaddis.edu.et/)
	 (v)	 Jimma Institute of Health Sciences (Jimma, Ethiopia) (URL: www.ju.edu.et/)

Acquiring Information Through Non-documentary Sources 
As far as non-documentary sources of information are concerned, private correspondence is still in wide 
use. Oral transmission of a particular topic is quite useful for acquiring information.
	 Agencies of non-documentary sources of information include:
	 1.	 Communication among small groups, such as:
	 (i)	 Suggestions from colleagues/friends,
	 (ii)	 Contacts with peers,
	 (iii)	 Off-prints from authors,
	 (iv)	 Journal clubs,
	 (v)	 Technological gatekeepers, and
	 (vi)	 Corridor meetings at conferences.
	 2.	 Communication among big groups, such as:
	 (i)	 Seminars and conferences, and
	 (ii)	 Invisible colleges (information exchange groups).
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	 3.	 New social information exchange tools like Blogs (fun keeping journals on the Internet–accessible 
to other users) and Twitter, such as:

	 (i)	 www.twitter.com			   (ii)	 ethiopiatwitter.blogspot.com
	 (iii)	 www.ethiopianreview.com	 (iv)	 www.african-safari-information.com
	 (v)	 twitter.com/ethiopiawire	 (vi)	 green.blogs.nytimes.com

Activity 1.1
A Report on Sources of Information in Education

Information can come from many sources — personal experiences, books, articles, expert opinions, 
encyclopaedias, the World Wide Web — and the type of information can change depending on the situation. 
In recent times, Ethiopia has shown encouraging signs in the expansion of utilizing ICT for multi-purposes. ICT 
plays a vital role in studying the sources of information in education sector all over the world.

Sources of Information
Look at the following sources of information. Notice the similarities between them. Keep in mind the following 
three questions:

	 1.	 Which sources can you find online?

	 2.	 Which sources guide you to other information on your topic?

	 3.	 Which sources would you use when writing a report?

	 	

	 	

	

	 	

Fig. 1.7: Some Sources of Information

Magazines Newspapers

EncyclopediasBooks

World Wide Web

Library Catalogue
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Searching Sources of Information in Education

The students can visit any school/college/institution in groups with their ICT teachers to know about the 
sources of information in education. There, students may find several sources of information which may be 
documentary (primary, secondary or tertiary sources) and non-documentary.

	 The students may find some sources of information in education like Periodicals, Laboratory Notebooks, 
Bibliographies, Reference Books, Yearbooks and Directories etc. in the school/college/institution. They may 
even look for some Blogs and Twitters on the World Wide Web.

	 Prepare a list of the sources of information in the form of a table as shown below.

Sources of Information

S.No. Primary Sources Secondary Sources Tertiary Sources Non-documentary

1. ............. ............. ............. .............

2. ............. ............. ............. .............

3. ............. ............. ............. .............

4. ............. ............. ............. .............

5. ............. ............. ............. .............

... ............. ............. ............. .............

 Finally submit the report to your ICT teacher and get it evaluated.

	    Key Concepts
	 	 Data is a collection of raw facts and figures or a raw input which when processed or arranged makes meaningful 

output.

	 	 Information is the data that is organized, meaningful and useful.

	 	 Technology is the usage and knowledge of tools, crafts, techniques, or systems, or methods of 
organizations.

	 	 Information Technology (IT) refers to anything related to computing technology, such  as networking, hardware, 
software, the Internet, or the people that work with these technologies.

	 	 An information ‘source’ can be categorized by the type of information it contains. The types are primary, 
secondary and tertiary.

Assessment 1.1
Fill in the Blanks
	 1.	 ICT stands for ...................................... .
	 2.	 ...................................... consists of raw facts and figures that are processed into information.
	 3.	 ...................................... is the usage and knowledge of tools, crafts, techniques, or systems, or methods of 

organizations.
	 4.	 The sources of information are usually classified as ....................., ..................... and .................... .
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State whether True or False
	 1.	 ICT is “the study of International Crime Technology”.
	 2.	 When computer and communications are combined, the result is Information and Communications 

Technology. 
	 3.	 Information is data that has been summarized or otherwise manipulated for use in decision-making.
	 4.	 The non-documentary sources are also called Informal Information Sources.

Answer the Following
	 1.	 Define data and information.
	 2.	 Give the differences between data and information.
	 3.	 Explain the term technology and information technology.
	 4.	 Write a short note on sources of information.

Suggested Activities
	 1.	 Explain and demonstrate the terms data, information and technology.
	 2.	 Explain and demonstrate the different sources of information.

Field Trips
	 1.	 Students should visit some big educational organization in their city. Interact with faculties there and 

prepare a report on “Basic concepts of ICT and sources of information”.
	 2.	 Students should visit some places like shopping centre, hospitals and science laboratory in their city and 

report on “Impact of ICT on everyday life”.

1.2 Generation of Computers

A computer is an electronic device that accepts, processes, stores and outputs data under the control of sets of 
instructions.
	 Computers have come across a long way to acquire the current form and capability. It took around 50 
years of continuous developments to bring the computer in its present form. The evolution of computers 
is mainly divided into five main generations. The computers of each of these generations have different 
properties.
	 Each new generation resulted in the following changes:

l First Generation Computers (1940–1956)
The U.S. census Bureau developed the first business computer in the year 1951. This computer was called 
Universal Automatic Computer (UNIVAC). It used vacuum tube (see Fig. 1.8) circuits for processing. The 
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Fig. 1.9: Transistor

computers that used vacuum tube circuits were called the First Generation Computers. The vacuum tube 
circuits contained a filament that was heated to emit electrons.
	 The main features of the first generation computers were as follows:
	 1.	 They used vacuum tubes.
	 2.	 They had a very big size.
	 3.	 They consumed huge electricity.
	 4.	 They were prone to failures.
	 5.	 They generated a lot of heat.
	 6.	 They only supported machine language.

l Second Generation Computers (1956–1964)

Bell Labs of U.S.A. invented transistors (see Fig. 1.9) that were used instead of vacuum tubes. Transistors 
are electronic circuits that are small in size. They do not emit electrons and do not require any heating. The 
computers that used transistors were called the Second Generation Computers.
	 The main features of the second generation computers were as follows:
	 1.	 They used transistors instead of vacuum tubes.
	 2.	 They were smaller in size as compared to the first generation computers.
	 3.	 They generated lesser heat.
	 4.	 They were more reliable and faster than the first generation computers.
	 5.	 They used core memories, magnetic tapes and disks.
	 6.	 They used lesser electricity.
	 7.	 They could be programmed by using machine as well as assembly 

language.

l Third Generation Computers (1964–1971)

The Third Generation Computers used Large Scale Integrated (LSI) circuits for processing. The LSI circuits 
were invented in mid 1960s. LSI circuits integrate several circuit components into a single chip.
	 The main features of the third generation computers were as follows:
	 1.	 They used integrated circuits (see Fig. 1.10).
	 2.	 They had a small size as compared to the second generation 

computers.
	 3.	 They consumed less electricity.
	 4.	 They were faster and reliable than the second generation 

computers.

	 5.	 They supported high level language.

l Fourth Generation Computers (1971–Present)

Very Large Scale Integrated (VLSI) chips were invented in the year 1969. The computers that used VLSI 
chips were called the Fourth Generation Computers.

Fig. 1.10: Integrated Circuit

Fig. 1.8: Vacuum Tube
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	 The main features of the fourth generation computers are:
	 1.	 They contain high-speed microprocessors.
	 2.	 They contain huge storage volumes in the form of magnetic and optical 

storage.
	 3.	 They contain main memories up to GBs (Gigabytes).

	 4.	 They are companied by great developments in the fields of networks.

l Fifth Generation Computers (Future)

Recent research has focused on developing “thinking computers”. These 
computers are called the Fifth Generation Computers.
	 Fifth generation computers will have the power to learn and apply knowledge to solve a problem. They 
would be able to work like humans do. You can watch a movie named “AI” by Steven Spielberg to have 
an idea of such computers.

	 Table 1.3 summarizes the key technologies and features of the various generations of computers.
Table 1.3: Comparison of Generations of Computers

Generation Period Circuitry Input Storage Output Language Examples

1st 1940–56 Vacuum 
Tubes

Punched Cards Magnetic 
tapes

Punch 
Cards

Machine 
Language

Univac, IBM 650, 
Burroughs 200

2nd 1956–64 Transistors Punched Cards, 
Magnetic tapes

Magnetic 
tapes

Punch 
Cards

Machine, 
Assembly

IBM 1400, 
Honeywell 200,

3rd 1964–71 Integrated 
Circuits 

(ICs)

Keyboards Magnetic 
Disks

Monitor Pascal, 
Fortran, 

Cobol, RPG

IBM System- 360

4th 1971– 
present

Very Large 
Scale Integ-

ration (VLSI) 
of circuits

Mouse, 
Scanners, 

Sound, etc.

Magnetic 
Disks with 

higher 
capacity

Monitor, 
Printers

RDBMS, etc. IBM System 
3760, HP 3000

5th Future With 
Artificial 

intelligence

Activity 1.2
Introduction to Artificial Intelligence

In small groups students will discuss “Introduction to Artificial Intelligence” based on the following information. 
The group leader from each group will give a brief presentation to the class based on the discussions.

Fig. 1.11: VLSI chip
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Artificial Intelligence

Artificial Intelligence (AI) is the ability of a computer or other machines to perform those activities that are 
normally thought to require intelligence.

or
	 Artificial Intelligence is the branch of computer science concerned with making computers behave like 
humans. 
	 The term was coined in 1956 by John McCarthy at the Massachusetts Institute of Technology, located in 
Cambridge, Massachusetts (United States).
	 Artificial intelligence includes:
	 1.	 Games playing: Programming computers to play games such as chess and checkers.

Fig. 1.12: Games Playing

	 2.	 Expert systems: Programming computers to make decisions in real-life situations (for example, some 
expert systems help doctors diagnose diseases based on symptoms).

	 3.	 Natural language: Programming computers to understand natural human languages.
	 4.	 Neural networks: Systems that simulate intelligence by attempting to reproduce the types of physical 

connections that occur in animal brains.
	 5.	 Robotics: Programming computers to see and hear and react to other sensory stimuli.

Fig. 1.13: A Robot — An AI tool

	 Currently, no computers exhibit full artificial intelligence (that is, are able to simulate the human behaviour). 
The greatest advances have occurred in the field of games playing.
	 Today, the hottest area of artificial intelligence is neural networks, which are proving successful in a number 
of disciplines such as voice recognition and natural-language processing.

	   Key Concepts

	 	 The computers that used vacuum tube circuits were called the First Generation Computers.

	 	 The computers that used transistors were called the Second Generation Computers.

	 	 The Third Generation Computers used Large Scale Integration (LSI) circuits for processing.

	 	 The computers that used Very Large Scale Integrated (VLSI) chips were called the Fourth Generation Computers.

	 	 Recent research has focused on developing “thinking computers”. These computers are called the Fifth 
Generation Computers. They would be able to work like humans do.
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Assessment 1.2
Fill in the Blanks

	 1.	 The evolution of computers is mainly divided into ............................ main generations.
	 2.	 Each new generation of computers resulted in decrease in ...................... and ..........................
	 3.	 The computers that used ............................ circuits were called the First Generation Computers.
	 4.	 ............................ generation computers will have the power to learn and apply knowledge to solve a 

problem.

State whether True or False
	 1.	 The computers of all the five generations have different properties.
	 2.	 The computers that used transistors were called the First Generation Computers.
	 3.	 The Third Generation Computers used integrated circuits.
	 4.	 The Fourth Generation Computers are companied by great developments in the fields of networks.

Answer the Following
	 1.	 List the generation of computers.
	 2.	 Compare the differences amongst each generation of computers.

Suggested Activity
		 Explain and demonstrate (pictorially or physically) each generation of computers.

Field Trip
	 Organize a field trip to various places such as government organizations and science laboratories to find out 

and report on:
	 Different generations of computers.

1.3 Types of Computers

Computers can be classified into super computers, mainframe computers, minicomputers, and 
microcomputers (personal computers) on the basis of the following:
	 1.	 Size
	 2.	 Cost
	 3.	 Performance
	 (i)	 Speed of processing data
	 (ii)	 Storage capacity
	 (iii)	 Ability to handle input and output devices
	 Let us classify the types of computers used today:

l Super Computers
	 (i)	 Super computers are the largest and fastest computers. They are also the costliest computers.
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	 (ii)	 They are used in fields like science and defence. These 
computers are used for designing and launching 
missiles, weather forecasting, biomedical research, 
aircraft design and automobile design.

	 (iii)	 There are only a few super computers throughout 
the world. Some examples are IBM Blue Gene/L, IBM 
Roadrunner and Cray Jaguar.

l Mainframe Computers
	 (i)	 Mainframe computers are more powerful than minicomputers.
	 (ii)	 They have high processing speeds and can store large amounts of 

data. They are used in wide area networks and support hundreds of 
users. However, these computers consume more electricity.

	 (iii)	 Some examples are IBM 3000 series and Univac 1180.

l Minicomputers

	 (i)	 Minicomputers are small general-purpose computers, also called mid-
range servers. These computers can perform more complex tasks and cost 
more than microcomputers.

	 (ii)	 They are larger in size and they have small to medium storage 
capacity.

	 (iii)	 They are used for processing data and analysing results of experiments. 
They are also used for controlling and monitoring production 
processes.

	 (iv)	 Some examples are PDP 11/42 and VAX 11.

l Microcomputers

	 (i)	 Microcomputers are also called Personal Computers (PCs). These computers use microprocessors.
	 (ii)	 They are small in size. Also, they do not have large storage capacities.
	 (iii)	 They can perform difficult tasks. They are used mainly for desktop publishing, accounting, statistical 

analysis, graphics designing and project management.

	 (iv)	 Some examples are Apple II, IBM PC, PS/2 and Macintosh.

	 A desktop microcomputer	 A tower microcomputer
Fig. 1.17: Two Microcomputers

Fig. 1.14: Super computer

Fig. 1.15: Mainframe computer

Fig. 1.16: Minicomputer
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	 Personal computer or PCs are the popular form of computers. Individuals as well as organizations use 
these computers. The classification of PCs is as:

	 1.	 Desktops: These PCs are those in which the case or main housing sits on a desk, with keyboard in 
front and screen (monitor) often on top.

	 2.	 Portables: These PCs are so small that they can be placed on your lap.
	 The difference between portables and desktops is that portables can be carried while travelling unlike 
desktops. The portables are classified as:
	 (i)	 Laptops: These are small-sized machines that have the same power of a desktop. The weight of a 

laptop is around 7 to 12 kg. The drawback of a laptop is that it is too bulky. Examples: Toshiba 5200C 
and SLT/286.

	 (ii)	 Notebooks: These are smaller than a laptop and are designed to overcome the drawbacks of a 
laptop. They have the size of a notebook but are as powerful as a desktop. They weigh 3 to 4 kg. 
Examples: Contura 3/20 and Acer AnyWare.

	 (iii)	 Palmtops or Personal Digital Assistants (PDAs): These are handheld computers which have the size 
of a pocket calculator. They are not as powerful as a desktop. PDAs combine personal organization 
tools — schedule planners, address books, to-do lists — with the ability in some cases to send e-mail 
and faxes. Example: HP95LX.

	
	 A Laptop	 A Notebook	 A Personal Digital Assistant (PDA)

Fig. 1.18: A laptop, a notebook and a Personal Digital Assistant (PDA)

l Characteristics of a Computer

Computers are capable of performing highly complex tasks, which human beings cannot perform efficiently. 
The following are the main characteristics of computers, which make them so powerful:

1.	 Speed
	 Computers work at an amazing speed without any mistakes. The work, which a normal person would 

complete in a few hours can be done within fractions of a second by a computer. Speed of computers 
is measured in terms of milliseconds (10–3 seconds), microseconds (10–6 seconds) or nanoseconds  
(10–9 seconds).

2.	 Accuracy

	 A computer performs its task with great accuracy. It never commits mistakes in processing the data. It 
produces errors when we enter inaccurate input, i.e., Garbage In Garbage Out (GIGO).
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3.	 Reliability

	 Computers are more reliable than human beings as they do not get bored of the repetitive tasks and 
never get tired.

4.	 Storage Capacity
	 A computer can store large amount of data. It can store various documents, articles, pictures, etc., in 

its memory which can be used whenever required. On the other hand, a human being can keep only a 
limited information in his/her mind and rest of the things, he/she forgets.

5.	 Versatility

	 A computer can perform various types of jobs. On a computer system, we can listen to songs while 
typing text or play games while working on any other package, do calculations, make drawings, surf 
the net, send e-mail, etc.

6.	 Reduction in Manpower

	 Earlier, the work in industries/factories was done by a number of persons. But with computers, it can 
be completed by a few persons and that too more accurately and efficiently. The advent of computer 
has reduced the need of manpower.

7.	 Paper Work can be Reduced

	 The use of computer reduces the burden of paper work in any organization. For example, record of 
each student of a school can be kept in the computer itself rather than keeping manual files for each 
student. Also, information regarding any student can be obtained easily and quickly with the help of a 
computer.

l Limitations of a Computer
Despite having various advantages, computers do have the following limitations that are the strengths of 
human beings. These are:

1.	 No Decision-making Ability
	 Computers cannot take any decisions. Human beings assist the computer to take the decisions. For 

example, suppose a street hawker is selling flowers. If such kind of flowers are already in our house, we 
will decide not to purchase them. Taking decision in this way, without the assistance of human beings, 
is not possible by a computer.

2.	 No Intelligence
	 Computers do not have intelligence of their own, they work according to the instructions given by 

humans.

3.	 No Emotions and Feelings
	 Computers are far away from emotions and certainly being machines, they cannot have feelings and 

instincts.
	 These limitations of computers are characteristics of human beings. Thus, computers and human beings 
work in collaboration to make a perfect pair.
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Activity 1.3
Uses of Computers

In small groups students will discuss “Some uses of computers” based on the following information. The group 

leader from each group will give a brief presentation to the class based on the discussions.

Computers are everywhere. Some of the modern uses of computers are:

1.	 Traffic Control System

		  Computers are used to control the movement of people, goods, 

and vehicles in order to ensure their safe, orderly, and expeditious 

(done with speed and efficiency) flow throughout the transportation 

system. Each of the five areas of transportation—roadways, airports 

and airways, railways, coastal and inland waterways, and pipelines—

have unique systems of control.

		  The traffic control system has improved worldwide so much that 

being mobile (whether walking or riding) has become a lot safer.

2.  Ticket Machines

The ticket machines are computerized vending machines that generate 
tickets.  Whatever the size, the process is the same. The person chooses 
the ticket type and quantity from the display. After choosing the payment 
method, the ticket is generated.

3.	  Cash Machines in Banks

	 A cash machine or an ATM (Automated Teller Machine) is an unattended 
machine (outside some banks) that dispenses money when a personal 
coded card is used.

	 The central bank of Addis Ababa is known as the National Bank of 
Ethiopia (NBE). Besides the central bank, there are many other banks in 
Addis Ababa. The ATM counters in Addis Ababa can be located at:

	 (i)	 Hilton Hotel, Ground Floor

	 (ii)	 Sheraton Hotel, Lounge

	 (iii)	 Wabe Shebelle Hotel, Ground Floor

	 (iv)	 Dembel Shopping Mall, Ground Floor

	   Key concepts
	 	 Super computers are the most powerful computers among digital computers.

	 	 Mainframe computers are designed to handle huge volumes of data and information.

	 	 Minicomputers are small general purpose computers, also called mid-range servers.

Fig. 1.19: An air traffic control system

Fig. 1.20: A ticket machine

Fig. 1.21: A cash Machine or 
an ATM
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	 	 Microcomputers are also called Personal Computers (PCs). These are classified into desktops and portables.

	 	 The main characteristics of a computer are: speed, accuracy, reliability, storage capacity, versatility, reduction 
in manpower and reduction in paper work.

Assessment 1.3
Fill in the Blanks
	 1.	 ........................... can be classified into super computers, mainframe computers, minicomputers and 

microcomputers.
	 2.	 ........................... are the largest and fastest computers.
	 3.	 ........................... are those computers in which the case or main housing sits on a desk, with keyboard in 

front and screen (monitor) often on top.

	 4.	 Personal Digital Assistants (PDAs) have the size of a ........................... .

State whether True or False
	 1.	 We cannot classify the computers on the basis of size.
	 2.	 Mainframe computers are more powerful than minicomputers.
	 3.	 Minicomputers cannot be called mid-range servers.
	 4.	 Laptops are small sized machines that have the same power of a desktop.

Answer the Following
	 1.	 Classify the types of computers used today.
	 2.	 List the characteristics of each type of computer.

Suggested Activity
	 Categorize the computers in terms of size, processing speed and capacity only.

Field Trips
	 1.	 Determine what types of computers are being used in your school. In which departments are the different 

types of computer used? What are they used for? How are they connected to other computers?
	 2.	 Organize a field trip to various places such as science laboratories and government organizations to find 

out and report on:
		  Types of computers and their uses.

1.4 Introduction to Data Representation

A digital computer works with binary number system. The binary number system has only two digits 
0 and 1. Inside the computer, binary number is represented by an electrical pulse. 1 means a pulse of 
electricity and 0 means no pulse.
	 Data is divided into three types—alphabetic data, numeric data and alphanumeric data. Alphabetic 
data is used to represent the alphabets. It consists of capital letters A–Z, small letters a–z and blank 
space etc. Alphabetic data is also called non-numeric data. Numeric data consists of ten digits  
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0, 1, 2, 3, 4, 5, 6, 7, 8, 9, two signs + and – and decimal point. Alphanumeric data is used to represent 
alphabetic data, numeric data, special characters and symbols.
	 One digit in binary number system is called a bit and combination of eight bits is called a byte. A byte 
is the basic unit that is used to represent the alphabetic, numeric and alphanumeric data.
	 All the data that is entered into a computer is first converted into the binary form and after processing, 
it is again converted to human readable form as shown in Fig. 1.22.

Fig. 1.22: Conversion of a letter to Binary form and back

	 We will learn about computer coding system later in this unit.

l Number Systems
There are different types of number systems that are used to represent data. You are already familiar with the 
decimal number system. The other useful number systems are binary, octal and hexadecimal. You may regard 
each digit as a box that can hold a number.
	 Let us discuss the various number systems:

Binary Number System

In the binary number system, there can only be two choices for representing data—either a "0" or a "1". 
	 The base or radix of the binary number system is 2.

Octal Number System

In the octal number system, there can be eight possibilities:
	 "0", "1", "2", "3", "4", "5", "6", "7". 
	 The base or radix of the octal number system is 8.

Hexadecimal Number System
In the hexadecimal number system, we have 16 symbols:
	 "0", "1", "2", "3", "4", "5", "6", "7", "8", "9", "A", "B", "C", "D", "E", and "F".
	 The base or radix of the hexadecimal number system is 16.
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	 As shown in Table 1.4, there is a direct correspondence between the binary system and the octal system, 
with three binary digits corresponding to one octal digit. Likewise, four binary digits translate directly into 
one hexadecimal digit. In computer usage, hexadecimal notation is especially common because it easily 
replaces the binary notation, which is too long and human mistakes in using the binary numbers are too 
easily made.

Table 1.4: Base Conversion Table

Decimal Binary Equivalent Octal Equivalent Hexadecimal Equivalent

0 0000 0 0

1 0001 1 1

2 0010 2 2

3 0011 3 3

4 0100 4 4

5 0101 5 5

6 0110 6 6

7 0111 7 7

8 1000 10 8

9 1001 11 9

10 1010 12 A

11 1011 13 B

12 1100 14 C

13 1101 15 D

14 1110 16 E

15 1111 17 F

l Conversion of Numbers from One Number System to the Other
We can convert a number in one system to the other system by following rules specified by the number 
systems. Following conversions are generally performed in calculations.

Decimal to Binary Conversion
To convert a decimal number to its equivalent binary number, follow these steps:
	 1.	 Divide the number by 2 and store the remainder.
	 2.	 Divide the quotient by 2 and store the remainder.
	 3.	 Repeat these steps until quotient becomes 0.
	 4.	 Write the remainders from bottom to top order.
	 This arrangement of remainder digits will be the binary equivalent of the number. Let us describe this 
conversion process with decimal number 23.
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2 23 Remainder

2 11 1

2 5 1 = 10111

2 2 1

2 1 0

0 1

Converting Decimal to Octal

To convert a decimal number to its equivalent octal number, follow these steps:
	 1.	 Divide the number by 8 and store the remainder.
	 2.	 Divide the quotient by 8 and store the remainder.
	 3.	 Repeat these steps until quotient becomes 0.
	 4.	 Write the remainders from bottom to top order.
	 The steps are same as in decimal to binary conversion with only one difference that the number is 
divided by 8 because, 8 is the base in octal number system. For example, 837 in decimal will be equal to 
1505 in octal.

8 837 Remainder

8 104 5

8 13 0 = 1505

8 1 5

0 1

Converting Decimal to Hexadecimal

To convert a decimal number to its equivalent hexadecimal number, follow these steps:
	 1.	 Divide the number by 16 and store the remainder.
	 2.	 Divide the quotient by 16 and store the remainder.
	 3.	 Repeat these steps until quotient becomes 0.
	 4.	 Write the remainders from bottom to top order.
	 The steps are same as in decimal to binary conversion with only one difference that the number is 
divided by 16 because, 16 is the base in hexadecimal number system. For example, 1715 in decimal will be 
equal to 6B3 in hexadecimal.

16 1715 Remainder Hexadecimal equivalent
16 107 3 3
16 6 11 B = 6B3

0 6 6
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Converting Binary to Decimal
You can convert a binary number back to decimal number by multiplying each digit from right side with 
increasing power of 2 and adding the result. This means, the first digit from right will be multiplied by 20, 
the second digit with 21 and so on. For example,
		  (10111)2	 =	 ?10
			   =	 1 × 20 + 1 × 21 + 1 × 22 + 0 × 23 + 1 × 24

			   =	 1 + 2 + 4 + 0 + 16
			   =	 23

Converting Octal to Decimal
We can also convert an octal number to decimal number by multiplying each digit from right side with 
increasing power of 8 and adding the result. This means, the first digit from right will be multiplied by 80, 
the second digit with 81 and so on. For example,
		  (1505)8	 =	 ?10
			   =	 5 × 80 + 0 × 81 + 5 × 82 + 1 × 83

			   =	 5 + 0 + 320 + 512
			   =	 837

Converting Hexadecimal to Decimal
We can also convert an hexadecimal number to decimal number by multiplying each digit from right 
side with increasing power of 16 and adding the result. This means, the first digit from right will be 
multiplied by 160, the second digit with 161 and so on. For example,
		  (6B3)16	 =	 ?10
		  (6B3)16	 =	 3 × 160 + 11 × 161 + 6 × 162	 (Here, B = 11)
			   =	 3 + 176 + 1536
			   =	 1715

Converting Binary to Octal
To convert a binary number to its equivalent octal number, follow these steps:
	 1.	 Divide the binary number into groups of three bits each beginning from right side.
	 2.	 Add 0s to the left, if last group is incomplete.
	 3.	 Convert each group into decimals.
	 For example, consider the following:
		  (101011)2	 =	 ?8
			   =	 101		 011
			   =	 5		  3
	 As	 101	 =	 1 × 20 + 0 × 21 + 1 × 22

			   =	 1 + 0 + 4 = 5
and	 011	 =	 1 × 20 + 1 × 21 + 0 × 22

			   =	 1 + 2 + 0
			   =	 3

	 Therefore,	 (101011)2	 =	 (53)8
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Converting Octal to Binary

To convert an octal number to its equivalent binary number, follow these steps:
	 1.	 Convert each digit octal number to its equivalent three digit binary number.
	 2.	 Combine all the binary groups into a single group.
	 For example, consider
		  (53)8	 =	 ?2
		  (53)8	 =	 5	 3
			   =	 101	 011
	 as	 101	 =	 5 and 011 = 3 in decimal (refer to Table 1.4)

	 Therefore,	 (53)8	 =	 (101011)2

Converting Binary to Hexadecimal
To convert a binary number to its equivalent hexadecimal number, follow these steps:
	 1.	 Divide the binary number into groups of four bits each beginning from right side.
	 2.	 Add 0s to the left, if last group is incomplete.
	 3.	 Convert each group into decimals.
	 For example, consider the following
		  (110101)2	 =	 ?16
			   =	 0011	 0101
			   =	 3		  5
	 as 0011 is 3 in decimal and 0101 is 5 in decimal (refer to Table 1.4).
	 Therefore,	 (110101)2	 =	 (35)16

Converting Hexadecimal to Binary
To convert a hexadecimal number to its equivalent binary number, follow these steps:
	 1.	 Convert every digit i.e., A to F of hexadecimal number (if any) to decimal equivalent.
	 2.	 Convert every decimal number to its equivalent four digit binary number.
	 3.	 Combine all the binary groups to form a single binary number.
	 For example,
		  3516	 =	 ?2
		  3	 =	 (0011)2	 (refer to Table 1.4)
		  5	 =	 (0101)2
	 Therefore,	 (35)16	 =	 (110101)2

It must be remembered that whatever number system one may use, the information stored in the 
computer memory is always in terms of binary digits. It is only for our convenience that we use octal 
or hexadecimal numbers.

l Computer Coding System

We are already familiar about different types of number systems. The computers convert the information, 
numeric or non-numeric, into binary form. Therefore, one must know how the data/information is stored 
in computer memory.
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	 A computer handles non-numeric data in addition to numerical data, that is, alphabets, punctuation 
marks and other special characters. Some predefined codes are used to represent the numeric and non-
numeric characters. These codes are known as alphanumeric codes. Any data or information is represented 
internally using the bits 0 and 1.

A computer system’s data/information storage capacity is represented by bytes, kilobytes, megabytes, 
gigabytes and terabytes.
	 1 Byte	=	8 bits
	 1 Kilobyte (KB)	=	210 bytes = 1024 bytes

		  1 Megabyte (MB)	=	1024 KB = 210 × 210 bytes = 220 bytes
		  1 Gigabyte (GB)	=	1024 MB = 210 × 220 bytes = 230 bytes
		  1 Terabyte (TB)	=	1024 GB = 210 × 230 bytes = 240 bytes

	 Let us discuss some useful codes for data representation:

BCD (Binary Coded Decimal)
Binary Coded Decimal (BCD) code is one of the early computer codes. The idea of this coding scheme is to 
convert each digit of a decimal number into its binary equivalent instead of converting the entire decimal 
value into a binary number. This makes the conversion process easier.
	 Table 1.5 shows BCD equivalent of each decimal digit. Since 8 and 9 require 4 bits, all decimal digits 
are represented in BCD by 4 bits.

Table 1.5: BCD equivalent of decimal digits

Decimal Digits BCD Equivalent

0 0000

1 0001

2 0010

3 0011

4 0100

5 0101

6 0110

7 0111

8 1000

9 1001

	 Note that each decimal digit is independently converted to a 4-bits binary number, and hence, the 
conversion process is very easy. Also note that when four bits are used, altogether 16(24) combinations are 
possible (refer to hexadecimal number system). However, from Table 1.5 you can see that only the first 10 
of these combinations are used to represent decimal digits. The remaining six arrangements (1010, 1011, 
1100, 1101, 1110 and 1111) have decimal values from 10 to 15. These arrangements are not used in BCD 
coding. That is, 1010 does not represent 1010 in BCD. Instead,
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		  1010	 =	 1
0001

0
0000 or 00010000 in BCD

	 Similarly,

		  1510	 =	 1
0001

5
0101 or 00010101 in BCD

	 In the discussion above, we have used a group of four bits to represent a digit (character) in BCD. 4-bits 
BCD coding system can be used to represent only decimal numbers because four bits are insufficient to 
represent the various characters used by a computer. Hence, instead of using four bits with only 16 possible 
characters, computer designers commonly use six bits to represent characters in BCD code. In 6-bit BCD 
code, the four BCD numeric place positions are retained but two additional zone positions are added. With 
six bits, it is possible to represent 64(26) different characters. This is sufficient to code the decimal digits 
(10), alphabetic letters (26 in number), and other special characters (28 in number). Table 1.6 illustrates 
coding of alphabetic and numeric characters in BCD.

Table 1.6: Alphabetic and numeric characters in BCD along with their Octal equivalent

Character BCD Code Octal
Equivalent

Character BCD Code Octal
Equivalent

Zone Digit Zone Digit

A 11 0001 61 S 01 0010 22

B 11 0010 62 T 01 0011 23

C 11 0011 63 U 01 0100 24

D 11 0100 64 V 01 0101 25

E 11 0101 65 W 01 0110 26

F 11 0110 66 X 01 0111 27

G 11 0111 67 Y 01 1000 30

H 11 1000 70 Z 01 1001 31

I 11 1001 71

0 00 0000 00

J 10 0001 41 1 00 0001 01

K 10 0010 42 2 00 0010 02

L 10 0011 43 3 00 0011 03

M 10 0100 44 4 00 0100 04

N 10 0101 45 5 00 0101 05

O 10 0110 46 6 00 0110 06

P 10 0111 47 7 00 0111 07

Q 10 1000 50 8 00 1000 10

R 10 1001 51 9 00 1001 11
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	 Example 1.1	 Write the binary digits used to record the word BASE in BCD.
	 Solution.	 In BCD notation:
				    B	 =	 110010 A = 110001 S = 010010 E = 110101
		  Hence, the binary digits

		  B A S E
110010 110001 010010 110101

		  will record the word BASE in BCD.
	 Example 1.2	 Using Octal notation, write the BCD coding for the word Digit .
	 Solution.	 In BCD notation:
				    D	 =	 64 I = 71 G = 67 I = 71 T = 23
		  Hence, the BCD coding for the word DIGIT in octal notation will be 

		  D I G I T
64 71 67 71 23

ASCII
Pronounced “ask-ee”, ASCII (American Standard Code for Information Interchange) is the binary code 
most widely used with microcomputers. It has replaced many of the special codes that were previously 
used by computer manufacturers.
	 ASCII 7-bit code can represent up to 128 characters. A letter, digit or special symbol is called a character. 
It includes upper-case and lower-case alphabets, numbers, punctuation marks, special characters and 
control characters.
	 ASCII 8-bit code can represent up to 256 characters. Table 1.7 shows ASCII 8-bit coding scheme for 
alphabets and digits.

Table 1.7: ASCII 8-bit Coding Scheme

Character Decimal ASCII–8 Character Decimal ASCII–8
A
B

65
66

0100 0001
0100 0010

a
b

97
98

0110 0001
0110 0010

     

O
P
Q

79
80
81

0100 1111
0101 0000
0101 0001

o
p
q

111
112
113

0110 1111
0111 0000
0111 0001

     

Y
Z

89
90

0101 1001
0101 1010

y
z

121
122

0111 1001
0111 1010

0
1
2
3
4

48
49
50
51
52

0011 0000
0011 0001
0011 0010
0011 0011
0011 0100

5
6
7
8
9

53
54
55
56
57

0011 0101
0011 0110
0011 0111
0011 1000
0011 1001
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UNIcode
Unicode uses two bytes (16 bits) for each character. It can handle 65,536 character combinations. Thus, 
it allows almost all the written languages of the world to be represented using a single character set. 
Formally,
	 Unicode provides a unique number for every character,
			  no matter what the platform,
			  no matter what the program,
			  no matter what the language.
	 Unicode standard covers the principal written languages of the America, Europe, the Middle East, 
Africa, India and Asia.

	   Key concepts
	 	 A digital computer works with binary number system.

	 	 All the data that is entered into a computer is first converted into the binary form and after processing, it is 
again converted to human readable form.

	 	 There are different types of number systems (binary, octal, hexadecimal) that are used to represent data.

	 	 We can convert a number in one system to the other system by following rules specified by the number 
system.

	 	 Some useful computer coding systems are BCD, ASCII and UNICODE.

Assessment 1.4
Fill in the Blanks
	 1.	 A digital computer works with ........................... number system.
	 2.	 A ........................... is the basic unit that is used to represent the alphabetic, numeric and alphanumeric 

data.
	 3.	 1 Kilobyte (KB) = ........................... bytes.

	 4.	 The full form of ASCII is ........................... .

State Whether True or False
	 1.	 The binary number system has only one digit 1.
	 2.	 We can convert a number in one system to the other system by following rules specified by the number 

system.
	 3.	 BCD code is one of the early computer codes.
	 4.	 UNICODE uses one byte (8 bits) for each character.

Answer the Following
	 1.	 Explain how data is represented in the computer.
	 2.	 Discuss in brief the number systems—binary, octal and hexadecimal.
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	 3.	 Perform the following inter-number system conversions:
	 (i)	 (101011)2	 =	 ( )10	 (ii)	 (25)10	 =	 ( )2
	 (iii)	 (759)10	 =	 ( )8	 (iv)	 (746)8	 =	 ( )2
	 (v)	 (59F)16	 =	 ( )2	 (vi)	 (9D)16	 =	 ( )10
	 (vii)	 (11101)2	 =	 ( )8	 (viii)	 (47)8	 =	 ( )10
	 (ix)	 (79)10	 =	 ( )16
	 4.	 Write short notes on the following computer coding systems:
	 (i)	 BCD	 (ii)	 ASCII	 (iii)	 Unicode

Suggested Activity
	 Introduce an idea of the complexity of data representation in computer.

1.5 computer system

A computer is an electronic device that can accept data and instructions, store and process it to produce 
the required result.

The acronym for computer  is “Common Oriented Machine Particularly Used for Trade, Education 
and Research”.

	 The computer mainly consists of hardware and software components. Both of these work together to 
process data. Figure 1.23 illustrates these two components.

Fig. 1.23: Hardware and software

Hardware

The physical components of the computer that can be seen and touched are called as hardware. The 
term hardware is used to refer to all the components inside or outside the computer. In addition to 
this, components used to interconnect two or more components, for example, wires are also regarded as 
hardware. We have several hardware devices that are used at various phases of data processing cycle. 
The hardware that are used to supply input to computer are called as input devices. The hardware that are 
used to process the data, are called as processing devices and the devices that are used to present output 
of computer are called as output devices. Each of these categories has a broad variety of devices of various 
brands and qualities.

Software
The sets of instructions that instruct the computer to do different tasks are called as software. For example, 
word processing, games, painting, e-mail, spreadsheets etc.
	 Software is the driving force behind the working of computer. Without the presence of software, the 
computer is as good as a piece of plastic and metal. Hardware can be considered as organs and the software 
is life that moves inside these organs. Both of them cannot perform their function  without the presence of 
each other.
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l Hardware Components
Hardware consists of all the machinery and equipment in a computer system. The hardware includes, the 
keyboard, the monitor, the printer, and the “box” — the computer or processing device itself. Figure 1.24 
illustrates hardware of a computer.

Fig. 1.24: Hardware of a computer
		 The hardware components are given in Fig. 1.25.

Fig. 1.25: Hardware components

Input Devices
Input devices allow people to put data into the computer in a form that the computer can use, for example, 
keyboard and mouse.

Fig. 1.26: Input devices

Output Devices
Output devices translate information processed by the computer into a form that humans can understand—
print, sound, graphics, or video. For example, monitor, printer and sound speakers.

Fig. 1.27: Output devices
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System Unit
The system unit is also known as case. It is the box that houses the processor chip 
(CPU) i.e., the ‘brain’ of computer, the memory chips, and the motherboard with power 
supply, as well as some secondary storage devices—floppy-disk drive, hard-disk drive, 
and CD or DVD drive. The case comes in desktop or tower models. It includes a power 
supply unit and a fan to keep the circuitry from overheating.

Secondary Storage Devices
Within the motherboard in the system cabinet, the secondary storage devices are connected to it. Secondary 
storage or permanent storage stores your data as long as you want.
	 Let us discuss the commonly used secondary storage devices—Compact Disk (CD) and Digital Versatile 
Disk (DVD):

Compact Disk (CD)
The compact disk or CD is an optical storage medium. It is relatively cheap and has a storage capacity of 
up to 700 Megabytes of data. There are three main types of CDs:
	 (i)	 CD-ROM (Compact Disk—Read Only Memory): It is an optical-disk format that is used to hold pre-

recorded text, graphics and sound, for example, encyclopedias, software, games, e-books etc. It is a 
read-only disk. Read-only means that the disk’s content is recorded at the time of manufacture and 
cannot be written on or erased by the user.

	 (ii)	 CD-R (Compact Disk-Recordable): It is an optical-disk format on which data can be recorded only once 
but can be read many times. It allows users to make their own CD disks, though it is a slow process. 
Once recorded the contents cannot be erased. CD-R is often used by companies for archiving, that 
is, to store vast amounts of information.

	 (iii)	 CD-RW (Compact Disk-Rewritable): It is an erasable disk that allows users to record and erase data, 
so the disk can be used over and over again. CD-RW disks are used for archiving and backing up 
large amounts of data or work in multimedia production or desktop publishing, however, they are 
relatively slow.

Digital Versatile Disk (DVD)
The digital versatile disk or digital video disk or DVD is an optical storage medium. It is a CD-style disk 
but is able to hold about 15 times as much information and transfer it to the computer about 20 times as 
fast as a CD-ROM. There are three main types of DVDs:
	 (i)	 DVD-ROM (Digital Versatile Disk—Read Only Memory): It is a high capacity optical disk capable of 

storing 4.7 Gigabytes to 17 Gigabytes. It is a powerful and versatile secondary storage medium 
which was originally developed for the movie industry.

	 (ii)	 DVD-R (DVD-Recordable): It is similar to CD-R that 
allows users to write on the disk only once but read it 
many times. Recordable DVDs offer the user yet another 
option for storing large amount of data.

	 (iii)	 DVD-RW (DVD-Rewritable): Most writable DVD drives 
are DVD-RW. The DVD-RW disks can be recorded on 
and erased more than once.

	 DVD technology is bringing down prices these days.
		 Figure 1.29 shows how to use a CD/DVD.

Fig. 1.28: Case or 
system cabinet

Fig. 1.29: How to use a CD/DVD
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	Some secondary storage devices are also called input and output devices. For example, CD, DVD and 
Pen Drive etc.

l Types of Software
Software is generally divided into two main categories: System Software and Application Software. The system 
software are generally concerned with the various operations of a computer system and the application 
software are concerned with providing various services to the users. Figure 1.30 shows the two types of 
software.

Fig. 1.30: Types of software

System Software
System software is a set of master programs that keep the computer system working.
		 The basic components of system software are given below:

Operating System Software
Operating system is a bridge between the computer hardware and the user. Various types of operating systems 
are Windows, Mac OS, Unix, Linux etc.
	 Operating systems perform basic tasks, such as:
	 1.	Recognizing input from the keyboard
	 2.	 Sending output to the display screen
	 3.	 Keeping track of files and directories on the disk
	 4.	 Controlling peripheral devices such as disk devices and printers.

Language Software
A language acceptable to a computer system is called computer language or programming language. All 
computer languages can be classified broadly into the following three categories:
	 1.	 Machine Language
	 2.	 Assembly Language
	 3.	 High-level Language.

Low Level Language

Machine Language
Every computer understands only one language without using a translation program which is called 
machine language of the computer.

Assembly Language
A language that allows instructions and storage locations to be represented by letters and symbols instead 
of numbers is called assembly language or symbolic language.
	 Machine and assembly languages are often referred to as low-level programming languages.
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High Level Language
High-level programming languages overcome the limitations of low-level programming languages. The main 
feature of high-level languages is machine independence, i.e., portable (can be used on different computers 
with or without minor changes).
	 Today many different high-level languages are in use because each one was designed for a different 
purpose. For example, logo, Fortran, Cobol, Basic, Pascal, C, C++, C#, Java, RPG, LISP and 
Snobol.

Source Program and Object Program
Let us define source and object program: 
	 Source Program: A computer program written in high level language by a programmer that can be 
converted (or translated) into machine language.
	 Object Program: A computer program translated from an equivalent source program into machine 
language by a compiler or assembler.

Compilers and Interpreters
Computers work in machine language. These need translators for converting different computer languages 
into machine language. Compilers and interpreters are translators which are also known as language 
processors. 

Compiler
Compiler software translates a source program that is usually written in a high level language by a 
programmer into machine language. The compiler is capable of replacing single source program statement 
with a series of machine language instructions. For each language the machine requires a separate compiler. 
Figure 1.31 shows the working of a compiler.

Fig. 1.31: Working of a compiler

Interpreter
Interpreter software translates each source program statement into a sequence of machine instructions and 
then executes these machine instructions before translating the next source language statement. Interpreter is 
also unique for each high level language like compiler. Figure 1.32 shows the working of an interpreter.

Fig. 1.32: Working of an interpreter

Others

Program Utilities
Utilities are the programs that carry out general tasks such as formatting disks, storing files, virus checking. 
Some examples of utilities are text editors, backup utility, compression utility, disk defragmenter and antivirus 
software.
	 You can buy the utility programs at computer stores. Some utility programs are also available free of 
cost on the Internet.
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Device Drivers
Device drivers are programs which allow hardware devices such as the keyboard, printers to interface with 
the computer.
	 Modern operating systems have inbuilt support for a variety of input and output devices. For example, 
Windows XP contains drivers of hundreds of printers, scanners and other devices.

l Application Software
Application software allows the user to perform specific tasks. An application software, designed to satisfy 
one purpose may not be able to solve other purpose of the same user. For example, software for financial 
management cannot be used for designing two-dimensional graphics. Similarly, we have word processors 
for letter writing and presentation software for presentations. We cannot interchange the use of two 
application software with each other.
	 There are two main categories of application software: Pre-Written and Customised Application 
Software.
	 Pre-Written Application Software: These are designed for common needs of various businesses. For 
example, Word Processing Software, Electronic Spreadsheets, Presentation Software, Database Management 
Systems, Communication Software, Desktop Publishing Software.
	 Customized Application Software: These are created for a specific application of a specific environment. 
For example, software required by a publishing house. This type of software may not be useful for a 
computer assembling house who deals in the items having warranty period. Software engineers are hired 
to create such software. Different computer languages are used to create these software.

Types, Examples and Uses of Application Software

Application software can be classified in many ways—for productivity, speciality education/reference, 
entertainment, and personal uses. Figure 1.33 illustrates the types of application software.

Application Software

Productivity 
software

Speciality  
software

Education/
reference software

Entertainment 
software

Personal 
software

•	Word 
processing

•	 Spreadsheets
•	Database
	 management
•	Personal
	 information
	 management
•	Web browse
•	E-mail etc.

•	Presentation graphics
•	 Financial
•	Desktop publishing
•	Drawing & painting
	 (image editing)
•	Project management
•	Computer aided
	 design
•	Web page design
•	Video/audio editing etc.

•	Encyclopedias
•	Phone books
•	Almanacs
•	Library searches
	 etc.

•	Games, etc. •	Cookbooks
•	Medical
•	Home
	 decoration
•	Gardening
•	Home repair
•	Tax
	 preparation
	 etc.

Fig. 1.33: Types of application software
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	 Let us discuss some of the application software in brief:
	 (a)	 General purpose software: These software are useful in controlling the general activities of organizations. 

For example, MS-WORD, MS-EXCEL and DTP software.
	 (b) 	Speciality software: These software are used for a special purpose. For example, Peachtree.
	 (c)	 Entertainment software: These software allow a computer to be used as an entertainment tool. For 

example, Solitaire and Pinball.
	 (d)	 Educational software: These software allow a computer to be used as a teaching and learning tool. For 

example, Microsoft Encarta, Mavis Beacon and TypingMaster Pro.

l Features of Operating System
Operating System (OS) is a bridge between the computer hardware and the user. For example, Windows, 
Linux, Mac OS, Solaris, UNIX etc.
	 Windows provides a Graphical User Interface (GUI). A graphical user interface is simple to use because 
any action that is performed is in the form of button clicks or selection of commands.
	 Some of the features of an OS are given below:
	 1.	 Manipulates the files and folders on a computer.
	 2.	 Transfers files from one folder to another.
	 3.	 Finds a file or folders using a ‘search’ facility.
	 4.	 Customizes the computer desktop.
	 Let us discuss these features using Windows XP operating system.

Creating Folders or Directories
Folder is like a container, which can store programs, files and also other folders.
	 (i)	 To Create a Folder at the Desktop
	 1.	 Right-click in an empty area of the desktop.
	 2.	 From the pop-up menu so displayed, select New (see Fig. 1.34).

Fig. 1.34: Creating a folder at the desktop
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	 3.	 From the cascading menu, select the option Folder (see Fig. 1.34). A folder icon appears with the 
name ‘New Folder’ highlighted.

	 4.	 Type a name for the newly created folder and press Enter key.

	 (ii)	 To Create a Folder in a Drive/Folder

	 1.	 In ‘My Computer’ navigate to the item (drive/folder) in which you wish to create a new folder.

	 2.	 Double click on this item, so that a window exhibiting its contents is opened.

	 3.	 Right-click on an empty area in the window.

	 4.	 Select New from the pop-up menu displayed, and Folder from the cascading menu (see Fig. 1.35). 
A folder icon appears with the name ‘New Folder’ highlighted.

Fig. 1.35: Creating a folder in a drive/folder

	 5.	 Type a name for the newly created folder and press Enter key.

	 Say, you create a new folder called Software in the ICT folder. In this case, the ICT folder is called the 
parent folder and the Software folder is called the subfolder.
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Copying Files and Folders

To copy a file or a folder to another folder, perform the following steps:
	 1.	 Select the file or folder.
	 2.	 Click the Edit menu.
	 3.	 Click the Copy option.
	 Alternatively, you can right-click the file or folder, click the Copy option from the shortcut menu or 
press the Ctrl and C keys simultaneously (see Fig. 1.36).

Fig. 1.36: Copying files and folders

	 4.	 Select the folder where you have to paste the file or folder.
	 5.	 Click the Edit menu.
	 6.	 Click the Paste option.
	 Alternatively, you can right-click the folder, click the Paste option from the shortcut menu or press the 
Ctrl and V keys simultaneously.

A quick way to move and copy files or folders is to use right mouse button to invoke the shortcut menu 
(a menu which gets displayed by right click of mouse).

Moving Files and Folders
To move a file or a folder completely from one folder to another, perform the following steps:
	 1.	 Select the file or folder.
	 2.	 Click the Edit menu.
	 3.	 Click the Cut option (see Fig. 1.37).
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Fig. 1.37: Selecting the Cut option

		  Alternatively, you can right-click the file or folder, select the Cut option from the shortcut menu or 
press the Ctrl and X keys simultaneously.

	 4.	 Select the folder where you have to paste the file or folder.
	 5.	 Click the Edit menu.
	 6.	 Click the Paste option (see Fig. 1.38).

Fig. 1.38: Selecting the Paste option

	 If a number of files have to be copied or moved, it can be done using the Shift key or the Ctrl key. 
When you want to select consecutive files and folders, click the first item, hold down the <Shift> key and 
click the last item. When you want to select files that are not consecutive, hold down the <Ctrl> key and 
click each item. To select all files and folders in the window, choose Edit, Select All.
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Copying an item places an exact replica of the copied item at the new location also retaining the item 
as the location where it is copied from. But, moving an item from a location to another erases its 
existence at the original location.

Renaming Files and Folders
A file or folder can be renamed immediately after it is created or later.
	 To rename a file,
	 1.	 Select the file or folder.
	 2.	 Click the Rename option in the File menu.
	 3.	 Type a new name and press the <Enter> key.
	 Alternatively,
	 1.	 Right-click the file or folder.
	 2.	 Click the Rename option in the pop-up menu (see Fig. 1.39).
	 3.	 Type a new name and press the Enter key.

Fig. 1.39: Renaming files and folders

	 You can also select the file and press the F2 key to change the name.
	 The name of the file or folder is highlighted. Type the new name and press the Enter key.

Deleting a File or Folder
To delete a file or folder, perform the following steps:
	 1.	 Select the file or folder.
	 2.	 Press the Delete key.
	 Windows asks for confirmation before deleting a file 
or folder as shown in Fig. 1.40. Click Yes to delete the 
file or folder. Click No to cancel the operation.
	 Alternatively, you can right-click the file or folder 
and select the Delete option in the pop-up menu.
	 Deleted files and folders are stored in the Recycle 
Bin. If you delete any file by mistake, it can be restored 
by clicking the Restore option in the File menu of the Fig. 1.40: Deleting a File or a Folder
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Recycle Bin window. If any file or folder has to be deleted permanently from the machine, then right click 
on the Recycle Bin and select the Empty Recycle Bin option.
	 On clicking Empty Recycle Bin option the following message will be displayed (see Fig. 1.41).

Fig. 1.41: Confirm Multiple File Delete dialog box

	 Click Yes to permanently delete the files and folders from Recycle Bin.

Searching Files and Folders
To search files and folders, perform the following steps:
	 1.	 Click the Search option in the Start menu. The Search Results window appears.
	 2.	 Click the ‘All Files and Folders’ option.
	 3.	 Specify the name of the file or the folder that has to be searched.
	 4.	 Specify the folder in which the search has to be happened.

Fig. 1.42: The Search option

	 The results are displayed in the right pane. You can also access the Search option by pressing the Ctrl 
and E keys simultaneously.
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Customizing Computer Desktop

Arranging Icons on the Desktop
Icons can be arranged on the desktop. These can be dragged and placed anywhere on the screen. To 
automatically arrange these, perform the following steps:
	 1.	 Right-click on the empty space on the desktop.
		  A pop-up menu appears. A menu that appears when you click the right mouse button is called a 

context-sensitive menu.
	 2.	 Choose the Arrange Icons By option from the pop-up menu.
	 3.	 Click the Auto Arrange option (see Fig. 1.43).

Fig. 1.43: Auto Arrange Icon option

		  You can also arrange the icons by Name, Size, Type, etc.

Changing the Desktop Background
The background of a desktop can be changed. To change the background of the desktop, perform the 
following steps:
	 1.	 Right-click on the empty space on the desktop.
	 2.	 Click the Properties option (see Fig. 1.44).

Fig. 1.44: Properties option
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	 3.	 The Display Properties dialog box appears. Click the Desktop tab (see Fig. 1.45).
	 4.	 Select any option from the Background list box. For example, select Windows XP as the background 

and click the Apply button (see Fig. 1.45).
	 5.	 Click the OK button to close the dialog box.

Fig. 1.45: Changing background.

	 The background is also known as the wallpaper.

Changing the Screen Saver
Screen saver is a moving picture or pattern that appears on the screen when the mouse or the keyboard is 
not used for a specified period of time. You can set the time using the Wait spin box. To select the screen 
saver, perform the following steps:
	 1.	 Right-click on the empty space of the desktop.
	 2.	 Click the Properties option.
	 3.	 Click the Screen Saver tab (see Fig. 1.46).
	 4.	 Select any Screen saver from the list.
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	 5.	 Click the Apply button.
	 6.	 Click the OK button to close the dialog box.

Fig. 1.46: Changing Screen Saver

Changing the Appearance
The appearance of the desktop can be changed. To change the appearance of the desktop, perform the 
following steps:
	 1.	 Right-click on the empty space of the desktop.
	 2.	 Click the Properties option.
	 3.	 Click the Appearance tab (see Fig. 1.47).
	 4.	 Select any option from the list box. For example, select Windows XP style from Windows and 

buttons.
	 5.	 Click the Apply button.
	 6.	 Click the OK button to close the dialog box.
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Fig. 1.47: Changing the Appearance

You can change Color scheme and Font size depending on your choice.

	   Key concepts
	 	 A computer system consists of hardware components and software components.

	 	 Hardware are the physical parts of the computer that can be seen and touched.

	 	 Software are the sets of instructions that instruct the computer to do different tasks for example: word 
processing, games, painting, email, spreadsheets.

	 	 Software can be classified as systems and application software.

	 	 Operating system is a bridge between the computer hardware and the user.

Review Questions
Fill in the Blanks

	 1.	 A ........................... consists of hardware and software components.
	 2.	 Commonly used secondary storage devices are ........................... and ........................... .
	 3.	 ........................... software keep the computer system working.
	 4.	 ........................... are programs which allow hardware devices to interface with the computer.
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State Whether True or False
	 1.	 Hardware are the sets of instructions that instruct the computer to do different tasks.
	 2.	 System unit contains the motherboard, power supply and hard disk.
	 3.	 Program Utilities carry out general tasks such as formatting disks, storing files, virus checking etc.
	 4.	 An operating system cannot customize computer desktop.

Multiple Choice Questions
	 1.	  ICT focuses primarily on ....................... technologies.
			  (a)	 Water	 (b)	 Communication	 (c)	 Research	 (d)	 Transportation
	 2.	 Computers can be classified on the basis of the following.
			  (a)	 Size	 (b)	 Cost	 (c)	 Performance	 (d)	 All of these
	 3.	 Which of the following coding scheme uses two bytes (16 bits) for each character?
			  (a)	 EBCDIC	 (b)	 UNICODE	 (c)	 ASCII	 (d)	 BCD
	 4.	 A program written in high level language is known as ........................... .

			  (a)	 Main Program	 (b)	 Image Program	 (c)	 Object Program	 (d)	 Source program

Match the Following

Column A Column B
1. 	Social information exchange tool (a) 	2048 KB
2. Characteristics of a computer (b) Transistor
3. Megabyte (c) Integrated Circuit
4. Entertainment Software (d) Blog
5. First generation (e) 1024 KB
6. Second generation (f) Versatility
7. Third generation (g) Very Large Scale Integration
8. Fourth generation (h) Vacuum Tube

(i) Solitaire

Answer the Following
	 1.	 Describe the computer system.
	 2.	 List major hardware components of a computer system.
	 3.	 Define system software and application software. Give their uses also.
	 4.	 Give the features of an operating system.

Suggested Activities
	 1.	 Demonstrate and explain in brief a computer system.
	 2.	 Define and explain the difference between system software and application software.

Field Trip
	 Students should visit some big educational organization in their city. Interact with faculties there and prepare 

a report on the latest computer system in use.
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Application 
Software

   Unit Outcome
	 Students will be able to:

	 	 understand how to open word processing software, and create, and save a document;

	 	 recognize how to format a document in a desired way;

	 	 apply any of formatting features in their document;

	 	 understand how to open presentation software, and create and save a document;

	 	 recognize how to create a slide show using animation and sound.

2.1 word processor

Word processing software allows you to create, edit, format, print, and store text material. Word 
processor is the most common application software. The main advantage of a word processor is that 
it provides WYSIWYG (What You See Is What You Get) interface which helps you make changes 
quickly and easily.
	 The advantages of using word processor to create documents over typed documents are given 
in Table 2.1.

Table 2.1: Advantages of Word Processor

Typed Documents Documents Created Using Word Processors

Slow creating process Can be created quickly and easily

Difficulty in inserting pictures and images Pictures and images can be inserted easily

Looks messy after making corrections Error correction is simple and neat

	 Microsoft Word (MS-Word) is the most popularly used word processing application software 
that provides you with a number of useful and fabulous features to process the text.
	 Let us understand the word processing features using MS-Word.

l Open Word Processor
As mentioned earlier MS-Word is a member of the MS-Office family provided by Microsoft. It is a Windows 
based application. Let us assume that your computer has MS-Word 2007 installed on it.

Unit 2   
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Starting Microsoft Word 2007
To start MS-Word or Word, perform the following steps:
	 Click Start → All Programs → Microsoft Office → Microsoft Office Word 2007
	 This opens a blank new document (see Fig. 2.1).
	 The various parts of the blank document window are shown in this figure.

Fig. 2.1: Components of a Document window

	 Table 2.2 describes some of the components of a document window.
Table 2.2: Word Document Window Components

Component Description

Office Button Displays as a Microsoft Office logo and, when clicked, displays a list of 
options and most recently opened documents.

Quick Access Toolbar Contains buttons for commonly used commands.

Title Bar Displays document name followed by program name.

Tabs Contain commands and features organized into groups.

Ribbon Area containing the tabs and commands divided into groups.

I-beam Pointer Used to move the insertion point or to select text.

Vertical Scroll Bar Used to view various parts of the document.

Status Bar Shows details about  the document you are working on.
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	 Table 2.3 shows how to move around a document using the keyboard.
Table 2.3: Moving around a document using the keyboard

Key(s) Function(s)

<Up> arrow, <Down> arrow,
<Left> arrow, <Right> arrow

One character up, down, left and right

<Ctrl> + <Right> arrow Next word

<Ctrl> + <Left> arrow Previous word

<Home> Beginning of the line

<End> End of the line

<Ctrl> + <Home> Beginning of the document

<Ctrl> + <End> End of the document

<Ctrl> + <Page Up> Previous page

<Ctrl> + <Page Down> Next page

l Creating a New Document
If you are already working in MS-Word and you want to create a new document, then perform the following 
steps:
	 Click Office Button → New → Create
	 It displays the newly created document (see Fig. 2.2).

Fig. 2.2: Newly created Word document
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l Saving a Document
When you type in a document, the document is stored in the internal memory of the computer. Figure 2.3 
shows a typed passage in a document using MS-Word 2007.

Fig. 2.3: Typing a passage in a Document using MS-Word

	 Once you have created a document, you have to save it for future use and you must save it on a disk. 
To save means to preserve the document safely for future use.
	 To save a word document, perform the following steps:
	 1.	 Click the Office Button.
	 2.	 Click the Save option or Press <Ctrl + S>.
		  The ‘Save As’ dialog box is displayed.
		  This dialog box is displayed only under the following circumstances:
	 (i)	 When you have clicked ‘Save As’.
	 (ii)	 If you have clicked Save and you are saving the document for the first time.
	 3.	 Identify the location where you want to save. You must enter the name by which you want to save 

the document. Here, we have selected C: drive and given the file name doc1.docx (see Fig. 2.4).

Fig. 2.4: Saving a word document

	 4.	 Click the Save button.

MS-Word, by default, saves all the documents in the folder ‘My Documents’ with extensions .docx. 
However, you can save them elsewhere by selecting the desired location, from the ‘Save in:’ drop-
down list provided in the ‘Save As’ dialog box.
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l Closing a Document
After your work is complete you need to close the document without exiting from MS-Word. To close a 
document without exiting MS-Word, perform the following steps:
	 Click Office Button → Close
	 If you have not saved the document before closing, MS-
Word gives you warning asking to save the document (see 
Fig. 2.5).
	 From this dialog box:
	 (i)	 If you want to Save the document, click the Yes 

button.
	 (ii)	 If you do not want to Save the document, click the No button.
	 (iii)	 If you want to remove the message box, click the Cancel button.

l Editing a Document
Editing is the act of altering your document. Some Edit features are insert and delete, undelete, find and 
replace, cut/copy and paste, spelling and grammar checker, and thesaurus. All of these commands except 
spelling and grammar checker which is in the Review tab are in the Home tab.
	 When you edit text, you change text by either inserting text, deleting text or replacing text. To edit text, 
place the cursor at the required position and insert, delete or replace text.

  Useful Tip

	You must keep on saving document when working to avoid losing document when power goes 
off.

l Formatting a Document
When you wish to make a document both more attractive and easier to read, you use formats. All word 
processing programs have built-in format setting called defaults, which are designed such that you can 
easily override them.
	 When creating a document, formatting is usually a separate stage—often completed after the document 
has been entered. The ease of applying and changing formats lets you play with a document’s design.
	 MS Word works on the principle of ‘‘FIRST SELECTION THEN ACTION’’.
		 Formatting text means changing the text appearance by changing the alignment, style, font and font 
color. To format text, you need to use the Home tab.
		 In Home tab you have all the formatting tools readily available (see Fig. 2.6).

Fig. 2.6: Formatting tools in Home tab

Fig. 2.5: The warning dialog box



Unit – 2 Application Software

50	  	 Information Communication Technology — Grade 9 Student Textbook

Selecting the Text
For any text to be formatted, first it has to be selected. There are various ways of selecting the text, i.e., 
using the keyboard by pressing shift key with arrow keys or using the mouse.
	 Let us discuss some useful features of formatting a document:

Character Formatting
Select the character and format it as required i.e., change its appearance by changing font, style, size, color 
and changing font style.
	 We can apply the effects before typing as well as after typing the text (see Fig. 2.7).

Fig. 2.7: Character formatting

Paragraph Formatting
Select the paragraph and format it as required i.e., apply alignment (Left, Right, Centre and Justify), indent, 
line spacing, bullets and numbers, and draw boarders around it (see Fig. 2.8).

Fig. 2.8: Paragraph formatting
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Page Formatting
Page formatting includes features of MS-Word that are used to improve the appearance of the page. Select 
the entire page or selection and format it as required i.e., apply formatting features including page size, 
border, header and footer, margins, a page break and page numbering etc. (see Fig. 2.9).

Fig. 2.9: Page formatting

Spell Checking
Spell checking is a very big plus point while talking about word processing. You can spell check your 
document for wrong spellings.

The red and green wavy underlines are only visible on screen. These will not appear in print out.

	 There are two methods of correcting these errors. One method is to correct these errors one by one, 
picking them up. Secondly, you can spell check the whole document.
	 The steps for spell check of the whole document are:
	 1.	 Place the cursor at the beginning of the text in the document (refer to Fig. 2.3).
	 2.	 Select Spelling & Grammar from the Proofing Panel of Review tab.

OR
		  Press F7
		  This will initiate the spell checking process and will start the spell checking of the document with 

each word of the document being searched with the similar words available in the dictionary. If not 
found, it will point it out to you. Select the appropriate word from the suggestions box. Here, we 
will select “taught” to change the word “thought” (see Fig. 2.10).



Unit – 2 Application Software

52	  	 Information Communication Technology — Grade 9 Student Textbook

Fig. 2.10: Spell checking

	 3.	 After checking the spelling of the whole document, if there is no word left for checking, you will 
get the message shown in Fig. 2.11.

Fig. 2.11: Dialog box on completion of spelling and grammar check

	 4.	 Click OK.
	 5.	 Save and Close the document.
	 Remember, you can spell check a portion of the text or a word by just highlighting it and then clicking 
at Spelling & Grammar icon.

For protecting your document from unauthorized access you can encrypt document, restrict permission 
or add a digital signature. This can be done by performing the following steps:
Click Office Button → Prepare → Encrypt Document → Type password and Click OK → Reenter 
password → Click OK

Inserting Tables
Tables provide an easier and effective method of arranging the data in rows and columns. MS-word offers 
a set of commands for creation, modification and formatting of tables. To insert a table in your document 
follow these steps:
	 1.	 Open a document and enter some text in it (refer to Fig. 2.3).
	 2.	 Select the Insert tab.
	 3.	 Select the Table option from Tables panel. On clicking the Table option, a list will be displayed. 
	 4.	 Select the desired table size by moving the cursor on the table cells (see Fig. 2.12). Here, we select 

4 × 5 table.
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Fig. 2.12: Selecting the Table size

	 5.	 After clicking on the last cell of the selected table size, a table is inserted into the document at the 
insertion point below the text (see Fig. 2.13).

		  Now fill the table as per your requirement and save the document.

Fig. 2.13: Inserting data in the table



Unit – 2 Application Software

54	  	 Information Communication Technology — Grade 9 Student Textbook

You can also insert table using Draw Table option from Insert Table list, available in Table option of the 
Tables panel under Insert tab.

Inserting Pictures
Clipart or pictures are inserted to create effective documents. MS-word supports many popular picture 
formats, for example .wmf (window meta files). You can insert pictures from the disk as well as cliparts 
from the clipart gallery of MS-OFFICE. You can also insert downloaded pictures or pictures taken by your 
web cam or digital camera, into your documents.
	 The steps for inserting a picture are given below:
	 1.	 Open a document (refer to Fig. 2.3).
	 2.	 Click the Insert tab.
	 3.	 Select the Picture option from Illustrations panel (see Fig. 2.14). 
		 On clicking this button the Insert Picture dialog box will appear.

Fig. 2.14: Inserting Picture

	 4.	 Select the desired picture and click Insert button (see Fig. 2.15). Here, we have selected  
Water lilies.jpg.

Fig. 2.15: Insert Picture dialog box
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		  The selected picture will be inserted in the document at the insertion point (see Fig. 2.16).

Fig. 2.16: A document after inserting a picture

	 5.	 Save and close the document.

The picture may not move properly in your document, unless you select a wrapping style. To resize 
a picture, always stretch or compress them from corners. This will increase or decrease the height and 
width proportionally.

Activity 2.1
Inserting, Removing Unwanted Items and/or Changing Existing Ones in The 
Document and Also Applying Undo and Redo

Students will perform the following steps for doing the activity:

	 1.	 Open an existing MS-Word document as shown in Fig. 2.17.

Fig. 2.17: A Word document

	 2.	 Now make changes in it. First we delete the last line of the document and then change the word “hope” 
to “hopr” in the first line (see Fig. 2.18).
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	 3.	 To undo an action,

		  Click the  Undo icon in the title bar (see Fig. 2.18).

Fig. 2.18: The Undo option

		  After applying Undo, the document is shown in Fig. 2.19.

Fig. 2.19: After Applying the Undo option

		  You can undo the other action also if you wish to do so.

	 4.	 To redo an action,

		  Click the Redo  icon in the Quick Access Toolbar (see Fig. 2.20).

Fig. 2.20: The Redo option

		  After applying Redo, the document is shown in Fig. 2.21. We again get back “hopr” in place of 
“Hope”.

Fig. 2.21: After applying the Redo option
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	   Key concepts
	 	 Word processing software allows to create, edit, format, print and store text material.

	 	 MS-Word is a Windows based application.

	 	 A file created using MS-Word is known as a document.

	 	 Text can be entered anywhere in a document area by placing the cursor at that place.

	 	 The Undo option is used to undo the previous action and the Redo option will repeat the previous Undo 
action.

	 	 Formatting means changing the appearance of text.

Assessment 2.1
Fill in the Blanks
	 1.	 WYSIWYG stands for ........................... .
	 2.	 When you start MS-Word, a ........................... window appears.
	 3.	 To create a new document in MS-Word, click the Office Button, New option and ........................... button.
	 4.	 ........................... is the act of altering your document.

State Whether True or False
	 1.	 MS-Word is not a very popular word processing application software.
	 2.	 A document must be saved if it is required for future use.
	 3.	 Formatting text means changing the text appearance by changing the alignment, style, font and font 

color.
	 4.	 MS-Word does not offer a set of commands for creation, modification and formatting of tables.

Answer the Following
	 1.	 Explain the steps to create and save a word processing document in MS-Word.
	 2.	 What do you mean by formatting? Explain the formatting commands of MS-Word.
	 3.	 Explain spell checking in MS-Word.
	 4.	 Write steps to insert a table in MS-Word.

Suggested Activities
	 1.	 Locate where the word processing software is in the computer and create, save and close the 

document.
	 2.	 Explain and demonstrate how to change the appearance of text changing font, style, size, color and 

changing font style.
	 3.	 Explain and demonstrate powerful formatting features including header and footer, margins and the 

steps involved to insert and delete bullets, a page break, a header and footer, page numbers and date 
and time on a document you have already created.
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2.2 presentation software and techniques

Presentation software is a tool used to create visual presentations. These presentations are usually 
delivered in a slide show format, and can be created with a variety of programs. The programs 
make it possible to combine text and graphic elements to convey important information to a group 
of people all at once.
	 Microsoft PowerPoint is a presentation software that is used to create on screen slide shows, 
overhead projector slides audience handouts and speakers notes, it is a part of MS-Office suite of 
software. PowerPoint is the most widely used presentation software.

l Feature of a Presentation Package 
Some features of Presentation Packages are:
	 1.	 A presentation package helps both: the speaker with an easier access to his/her ideas and the 

participants with visual information.
	 2.	 Presentation packages can either supplement or replace the use of older visual aid technology, such 

as pamphlets, handouts, chalkboards, flip charts, posters, and slides etc. 
	 3.	 Many presentation packages come with pre-designed images (clip art) and/or have the ability to 

import graphic images. 
	 4.	 With the growth of digital photography and video, many presentation packages can handle these 

types of media to display them in a similar “slide show” format. 
	 5.	 The “add ons” or plugins for presentation packages can be used to enhance their capabilities. 
	 6.	 Certain presentation packages can also be used for web conferencing.

l Creating Slides using Text and Images

To start using PowerPoint:
	 	Click Start → All Programs → Microsoft Office → Microsoft Office PowerPoint 2007
	 The PowerPoint window appears as shown in Fig. 2.22.

Fig. 2.22: PowerPoint window
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A placeholder is a location on a slide marked with a border that holds text or an object.

	Let us create a new presentation using text and an image.
	 1.	 Type the desired text in the title box.
	 2.	 To add an image click on Insert tab.
	 3.	 Click on the Picture icon in the Illustrations command group. 
	 4.	 Select the image file you want to insert and then click Insert (see Fig. 2.23).

Fig. 2.23: Inserting an Image

		  The selected image will be inserted in the slide. Now adjust the image position as per your need 
(see Fig. 2.24).

Fig 2.24: Entering Text and an Image in a slide

l Formatting Text and Background
Presentation software allows you to apply different formats to different parts of slide. Formatting refers to 
the act of changing the appearance of text i.e., changing the way it appears on screen and paper. Formatting 
a slide means changing the formats of characters, words, paragraphs of a slide to provide them an effective 
look and feel.
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	 We can change the appearance of text in a number of ways. We can change font, size, color, highlight 
and other special effects by using Home tab. We can apply the effects before typing as well as after typing 
the text. We can also change the background of slides using the Design tab. 
	 To format the text and background, perform the following steps:
	 1.	 Select the placeholder that contains the text you want to format.
	 2.	 Click on the Home tab and select the desired font style and size from the Font command group.
	 3.	 Click on Format tab and select the desired text style from WordArt Styles (see Fig. 2.25).
	 4.	 For changing the background of slide, click on the Design tab and select appropriate theme from 

Themes command group. The background color can be changed by selecting the Background Styles 
from Background command group (see Fig. 2.25).

Fig. 2.25: Slide after formatting Text and Background

l Inserting and Deleting Slides 
To insert a new slide, perform the following steps:
	 1.	 Right click on the Slides tab (see Fig. 2.26).
	 2.	 Click on  New Slide to insert a new slide. A new slide will be inserted (see Fig. 2.27).

		  Fig. 2.26: Inserting a slide	 Fig. 2.27: Slide after insertion 
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	 To delete a slide, perform the following steps:
	 1.	 Right click on the slide you want to delete (see Fig. 2.28).
	 2.	 Click on the Delete Slide option (see Fig. 2.28). The selected slide will be deleted.

Fig. 2.28: Deleting a Slide

l Presenting a Slide Show
This is the most useful view of PowerPoint. It is used to display the slides in a desired sequence.

	 In this view the slides are displayed one by one from first slide to the last slide, in full screen mode.

	 First of all prepare a presentation on any topic of your choice. Here, we have prepared the presentation 
on “Ethiopian Treasures”.

	 To  start the Slide Show, perform the following steps:

	 1.	 Click Start → All Programs → Microsoft Office → Microsoft Office PowerPoint 2007.

	 2.	 Click on Office Button and select Open.

	 3.	 Select the appropriate file name and press Enter key or Double click on the file. The desired file will 
be opened.

	 4.	 Click the Slide Show tab.

	 5.	 Click the From Beginning icon in the Start Slide Show command group (see Fig. 2.29). PowerPoint 
displays the first slide of your presentation.
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Fig. 2.29: Getting ready for presenting a Slide Show

	 6.	 Click the mouse or press the space bar to view the next slide.
		  The slides in the presentation are show below:

	 	

	 Slide 1	 Slide 2

	 	
	 Slide 3	 Slide 4

	 	

	 Slide 5	 Slide 6



Unit – 2 Application Software

	 Information Communication Technology — Grade 9 Student Textbook	 	 63

Slide 7

Fig. 2.30: Slide show
	 7.	 Press Esc to exit the Slide Show.

l Create a Slide Show using Animation and Sound

Presentation Software allows you to add various multimedia effects to the slides and the objects created 
on slides. The presentations, you have created so far, contain no animation, timings, sounds and transition 
effects. Professionally designed slide shows contain all these properties to grasp the attention of the 
audience. 

Applying Animation
To apply animation to your PowerPoint slide, perform the following steps:
	 1.	 Open the slide to which you want to apply the animation.
	 2.	 Click on the Animations tab and select the desired transition style from the Transition to This Slide 

command group (see Fig. 2.31).

Fig. 2.31: Applying Animation 

		  You can also apply animation to a title, a sub title, and an image in your slide individually by using 
Custom Animation from Animations command group (see Fig. 2.32). 

Fig. 2.32: Applying Custom Animation
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	 3.	 Now select the desired effect from Add Effect which you want to apply for a particular image or text. 
The selected applied effect is shown in Fig. 2.32.

Applying Sound
You can add sound to the transition effects and to the preset animation. You can also add audio to your 
presentation by inserting files from Clip Art Gallery or from other folder available to you. 
	 PowerPoint can use audio files stored in common formats such as AIFF, MIDI, MP3 and WAV file. If 
your audio file is stored in a different file format, such as Real Audio, you will have to convert the file 
before you can add it to a PowerPoint presentation.
	 To add an Audio File, perform the following steps:
	 1.	 Select the slide to which you want to put an audio.
	 2.	 Open the Insert tab and click on the Sound icon from the Media Clips command group. The Insert 

Sound dialog box appears (see Fig. 2.33).

Fig. 2.33: Inserting Sound

	 3.	 Choose the desired sound file you want to add and click OK.

	 PowerPoint displays a dialog box asking whether you want to play the sound automatically or when 
you click the mouse (see Fig. 2.34). Choose your option. A horn icon is displayed which means that the 
sound has been inserted (see Fig. 2.35).

	 Fig. 2.34: Selecting Sound Starting Option	 Fig. 2.35: Horn Icon
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	 Sound icon is displayed on your slide. You can move it so that it does not obscure your slide (see  
Fig. 2.36). 

Fig. 2.36: Slide after Applying Sound

A color scheme defines the font sizes, and color of title, subtitle, bullets and numberings in slide. You can 
select a readymade color scheme or you can customize the color scheme as you like.

l Change Slide Layout
The slide layout in PowerPoint is the arrangement of all the items that make up your slide, such as title, 
graphics or text boxes.
	 To change the layout of slide, perform the following steps:
	 1.	 Open the presentation.
	 2.	 Open the Home tab and click on the Layout button from Slides command group. Apex dialog box 

will appear (see Fig. 2.37). 

Fig. 2.37: Apex dialog box

	 3.	 Choose the desired layout style from the list. The selected layout will be applied to the current 
slide.
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	   Key concepts
	 	 Presentation software is a tool used to create visual presentations.

	 	 A presentation package helps both: the speaker with an easier access to his/her ideas and the participants 
with visual information.

	 	 We can make slides using features such as creating slides, inserting text, formatting text, inserting clipart, 
formatting background, inserting slides, deleting slides and inserting images from other files.

	 	 Presenting a slide show is the most useful view of PowerPoint. It is used to display the slides in a desired 
sequence.

	 	 The slide layout in PowerPoint is the arrangement of all the items that make up your slide, such as title, 

graphics or text boxes.

Review Questions
Fill in the Blanks
	 1.	 PowerPoint is the most widely used ........................... software.
	 2.	 Certain presentation packages can also be used for web ........................... .
	 3.	 ........................... a slide means changing the formats of characters, words, paragraphs of a slide to provide 

them an effective look and feel.

	 4.	 You can add ........................... to the transition effects and to the present animation.

State Whether True or False

	 1.	 Microsoft PowerPoint is not a part of MS-Office suite of software.
	 2.	 To start using PowerPoint:
		  Click Start → All Programs → Microsoft Office → Microsoft Office PowerPoint 2007.
	 3.	 The slide show cannot display the slides in a desired sequence.
	 4.	 We can change the layout of slide using presentation software.

Multiple Choice Questions
	 1.	 Microsoft Word is a/an ........................... .
		  (a)	 Operating System			   (b)	 Database software
		  (c)	 Spreadsheet software		 (d)	 Application software
	 2.	 Which of the following is not a feature of word processing?
		  (a)	 Spell checker			   (b)	 Cell address
		  (c)	 Cut and Paste			   (d)	 Undo and Redo
	 3.	 ........................... is a presentation software?
		  (a)	 MS-Word 			   (b)	 MS-Excel	
		  (c)	 MS-PowerPoint			   (d)	 MS-Access
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	 4.	 Which of the following is/are included in the slide layout in PowerPoint?
		  (a)	 Title			   (b)	 Graphics	
		  (c)	 Text boxes			   (d)	 All of these

Match the Following

Column A Column B

1. 	Pressing Backspace key (a) Encrypt Document
2. Increase the security of the document (b) Deletes character to the left of the insertion 

point
3. Slide Show (c) Used to apply the animation
4. Animations tab (d) Used to display slides in a desired sequence

Answer the Following
	 1.	 Write the steps to create a presentation.
	 2.	 How will you prepare and present a slide show?
	 3.	 How will you create a presentation using design techniques?
	 4.	 Write the steps to change the layout of a slide.

Suggested Activities
	 1.	 Explain and demonstrate the slide making features such as creating slides, inserting text, formatting text, 

inserting clipart, formatting background, inserting slides, deleting slides and inserting images from other 
files.

	 2.	 Explain various design techniques such as design templates, animation scheme, color schemes and 
adding sound.

	 3.	 Each group of students to present their slide shows to the class, giving explanations as necessary, 
presentation software, spare paper, magazines, newspapers, reference books etc.

Field Trip
	 Organize a field trip to various historical places in Ethiopia to get useful information and present the slide 

shows to the class.
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Information and 
computer Security

   Unit Outcome
	 Students will be able to:

	 	 understand the responsible behaviour in the computer laboratory;

	 	 recognize the nature of computer virus and measure to protect.

3.1 information and computer security

Security of information and related computer systems is a big concern for the computer users. So, 
the effective methods of protection are required. In this unit, you will learn about information and 
computer security.

l Responsible Behaviour in the Computer Lab
A computer laboratory is a special place which contains delicate and expensive equipment (see  
Fig. 3.1). 

Fig. 3.1: Students working in a computer lab

	 In order for the computer lab to maintain the equipment and an excellent learning environment you 
must behave in a calm manner and not damage any machines or furniture; you must not touch any 
electrical connection for any reason.
	 You need to follow some guidelines for responsible behaviour in the Computer Lab. These are:
	 1.	 Students are not allowed in the computer lab unless directly supervised by a computer teacher or 

any other staff member.
	 2.	 Never share your password, even with your best friend.

Unit 3   



Unit – 3 Information and Computer Security

	 Information Communication Technology — Grade 9 Student Textbook	 	 69

	 3.	 No gum, eat or drinks in the computer lab, electronic equipment does not like to get wet or 
sticky.

	 4.	 Listen to directions given by your computer teacher.
	 5.	 Review your notes, on-line materials and of course the HELP option in all programs.
	 6.	 Only use the Internet as instructed. Do not click on links that seem suspicious or are offers of “free” 

anything.
	 7.	 Do not use the mouse or keyboard as a toy, that is, do not randomly click on the mouse or hit the 

keys on the keyboard without a purpose.
	 8.	 Do not change computer preference settings or endeavour to “hack” into unauthorized areas.
	 9.	 Always use print preview before you print. 
	 10.	 Take permission from your computer teacher before printing.
	 11.	 Before leaving from the computer lab you should follow these procedures: 
	 (i)	 Exit any programs you are using. The login screen should be showing on the desktop. Return 

supplies (if any).
	 (ii)	 Straighten your work area and retrieve your books from the book shelf.
	 (iii)	  Log Off/Turn Off your computer and push in your chair. 

Do not give own or another’s data to anyone. E-mail address should not be given to anyone. Always 
stick to safe on-line behaviour. 

Sanctions

It is always expected that students will follow these rules and codes of behaviour; there may be occasions 
when sanctions will need to be invoked (called upon), including:
	 1.	 Temporary removal from the lesson (time out).
	 2.	 A temporary or permanent ban on Internet use or even using the computers in general. (Parents 

would usually be informed at this stage.)
	 3.	 When necessary, police or local authorities may have to be involved.
	 4.	 Additional disciplinary action may be added in line with existing practice on inappropriate language 

or behaviour.

l School ICT Policy 
“Information and Communication Technology (ICT) prepares pupils to participate in a rapidly changing 
world in which work and other activities are increasingly transformed by access to varied and developing 
technology. Pupils use ICT tools to find, explore, analyze, exchange and present information responsibly, 
creatively and with discrimination. They learn how to employ ICT to enable rapid access to ideas and 
experiences from a wide range of people, communities and cultures. Increased capability in the use of ICT 
promotes initiative and independent learning; with pupils being able to make informed judgements about 
when and where to use ICT to best effect, and consider its implications for home and work both now and 
in the future.”
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	 Table 3.1 gives some responsibilities of the schools relating to ICT, which need to be allocated.
Table 3.1: Some Responsibilities Relating to ICT

Managing the implementation of ICT policy Ensuring safe on-line behaviour

Ensuring staff access to ICT Assessment of students

Ensuring attitude towards ICT Overseeing equipment maintenance

Ensuring ICT progression Health and safety policy and practice

Purchasing/organizing ICT resources Reviewing the ICT policy

	 The following points must be included for implementing the ICT policy:
	 1.	 How does the school ensure that all students have opportunities to use ICT according to their 

needs?
	 2.	 How does ICT help to give students with special educational needs access to the whole 

curriculum?
	 3.	 How does ICT support gifted students?
	 4.	 How is the gender issue handled?
	 5.	 What account is taken of pupils’ use of ICT at home?

All pupils should be given equal access to ICT within the school with appropriate arrangements being 
made to support individual needs, when and where necessary.

Developing a school ICT policy 
The school ICT policy means the rules prepared by the school to use ICT. The ideas given here should 
be adapted to ensure that the policy is appropriate and relevant for your school. When deciding on the 
school’s aims for ICT, internal, local and national factors should be considered.
	 The school’s overall aim for ICT is to enrich learning for 
all students. The school management must ensure that ICT 
Co-ordinator and computer teachers develop confidence and 
competence to use ICT as a tool aiding effective teaching across 
the curriculum (see Fig. 3.2).
	 The school ICT policy must identify the important issues 
and guide the students to live with it. Some of these include:
	 1.	 A statement defining ICT capability.
	 2.	 The aims for ICT in the school.
	 3.	 Guidance on record-keeping, assessment.
	 4.	 Guidance on health and safety.
	 5.	 Specific rules for the use of Internet and E-mail.
	 6.	 Statement of the school’s position on copyright, data protection.
	 7.	 Information regarding maintenance/repair/viruses.
	 8.	 Date for review. 

The day-to-day organization procedures, guidance, rules and other operational matters should be placed 
in a school handbook.

Fig. 3.2: ICT Co-ordinator addressing the 
students about ICT policy
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Student’s Acceptance of the School’s ICT Policy 

Please complete and return this form to the ICT Co-ordinator or Computer Teacher.

Student’s agreement:

I have read and understood the school rules for ICT policy. I will use the computer systems 
and Internet in a responsible way and obey these rules at all times. 

I understand that if I break these rules then I may not be allowed to use the Computer 
Lab.

Student’s signature ___________________________ 	 Date ___/___/___

Parent’s/Guardian’s Acknowledgement:

I have read and understood the school rules for ICT policy and give permission for my son/
daughter to live with it. I understand that the school will take all reasonable precautions 
to ensure that students cannot access inappropriate materials, although I understand that 
the school cannot accept liability for the material accessed, or any consequences of Internet 
access.

Parent’s/Guardian’s signature ______________________ 	 Date ___/___/___
Name of Student _____________________________
Grade ____________

l Nature of Computer Viruses
Computer viruses are software programs like other applications. But they get attached with the general 
applications and use their setup or .exe file to get installed on the computer system. Computer viruses are 
proving to be main cause of crashing computer system. To solve or remove viruses from computer, install 
any updated Anti-Virus software on your PC and perform a system scan. 
	 Let us focus on the nature, recovery and prevention of computer viruses.

Computer Viruses

A computer virus is a malicious program that is designed to corrupt or 
delete the information stored in the computer. You will know if you have a 
computer virus very quickly, because nothing will function as it should. If 
other computers are connected to this computer by network or e-mail, the 
virus can be spread very quickly because the virus replicates itself to enter and 
infect these computers (see Fig. 3.3).

Fig. 3.3: Computer virus can 
create problems on computer
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	 These viruses do basically three types of damage to the computer it affects:
	 1.	 First is Trojans or worms which are designed to steal important personal information such as your 

ID’s, passwords, account numbers, and other personal information found on your computer.
	 2.	 Second type is designed to gain access to your machine and then hijack it. Once it has control of 

the affected computer a hacker can use it for malicious purposes or as a spam machine to send 
thousands of unwanted e-mails.

	 3.	 Third type is sometimes referred to as macro viruses. This type of virus is designed so they can 
delete or overwrite the system or data files on the affected computer. This causes the computer to 
crash and become unbootable or non-operable. Many of the computers that get this type of virus 
have a crashed hard drive which is not repairable and all your data is lost permanently.

Computer Viruses are spread through transportable secondary storage devices and networks.

Measures Protect
The best way to protect computer viruses is installing antivirus software. Antivirus software consists of 
computer programs that attempt to identify, thwart and eliminate computer viruses and other malicious 
software (malware).
	 Good antivirus software comes with features like a built-in firewall and usually offers an access to 
online data backup. This antivirus software has the option to deactivate the malicious viruses. 
	 Firewalls are systems which help protect computers and computer networks from attack and subsequent 
intrusion (see Fig. 3.4).

Fig. 3.4: Firewall

	 The antivirus software protects your computer from virus attacks in three main ways:
	 1.	 The first way is prevention which involves detecting and eliminating new viruses from your 

computer. They get the latest virus definitions from their server so they know what to look for and 
protect against. 

	 2.	 The second way is cleaning infected computers. This involves detection and extermination of the 
virus, along with repairing the damaged files. 

	 3.	 The third way is protecting your computer by monitoring e-mails, downloads and protection while 
Internet surfing i.e., on-line. The antivirus regularly scans the computer or a preset scheduler to keep 
your computer virus free. 
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	 Figure 3.5 illustrates Norton and Quick Heal antivirus:

Fig. 3.5: Norton and Quick Heal Antivirus

	 As mentioned earlier antivirus software is very effective in finding and deleting harmful computer 
viruses. The computer users should follow these safety rules to protect against viruses:
	 1.	 Do not open unsolicited e-mails.  
	 2.	 Never download an attachment to an e-mail without scanning it for viruses first. 
	 3.	 Make sure you also use a firewall. 
	 4.	 Do not download free software or music. 
	 5.	 Do not use free antivirus software. 
	 6.	 Search on Internet for antivirus reviews and research yourself for best antivirus software.

Microsoft Malicious Software Removal Tool protects your system from Computer Viruses. You can 
download and install this software from official website of Microsoft. This software is compatible with 
Windows 7, Vista, XP and Windows server 2003. At the end of the process, you will get a thorough 
report about any malicious software that have been detected and removed.
	Turn on Automatic updates on your system and then perform the following:
Click Start → Control Panel → System → Automatic Updates

Activity 3.1
Responsible Behaviour in the Computer Laboratory

In small groups students will discuss “Responsible Behaviour in the Computer Laboratory”. The group leader 
from each group will give a brief presentation to the class based on the discussions.

Computer Laboratory

A computer laboratory is a special place which contains delicate and expensive equipment.

Fig. 3.6: Computer laboratory
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To keep your computer laboratory and computers in proper working condition, it is necessary to behave in a 
calm manner and not damage any machines or furniture. You must not touch any electrical connections for 
any reason.

Points to be borne in mind while working in the computer laboratory:

  Do’s

	 1.	 Sit properly and behave in a calm manner.

Fig. 3.7: Responsible behave in computer lab

	 2.	 Only use the Internet as instructed.

	 3.	 Ensure that the power switch on the system unit, monitor and printer are in the OFF position before 
switching off the mains.

  Do nots

	 1.	 Do not shout.

 

Fig. 3.8: Shouting is not allowed

	 2.	 Do not damage any machines or furniture.
 

Fig. 3.9: Damaging is not allowed
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	 3.	 Do not allow eating or drinking near the computer.

	 4.	 Do not touch any electrical connections.

Fig. 3.10: Touching an electrical connection can be very dangerous

	 5.	 Never share your password, even with your best friend.

	Always remember that responsible behaviour in the computer laboratory will help you in the ICT field 
forever.

	   Key concepts
	 	 Security of information and related computer systems is a big concern for the computer users.

	 	 Computer laboratory contains delicate and expensive equipment.

	 	 In computer lab; students must behave in a calm manner and not damage any machines or furniture; they 
must not touch any electrical connections for any reason.

	 	 School ICT policy means rules prepared by the school and students must live with it.

	 	 Computer viruses are software programs which are proving to be main cause of crashing computer system. 
The best way to protect computer viruses is installing antivirus software.

Review Questions
Fill in the Blanks
	 1.	 Computer laboratory contains ........................... and ........................... equipment.
	 2.	 In computer laboratory, the students must not touch any ........................... connections for any reason.
	 3.	 A ........................... is a malicious program that is designed to corrupt or delete the information stored in 

the computer.
	 4.	 The ........................... software protects your computer from virus attacks.

State Whether True or False
	 1.	 Security of information and computer systems is not a big concern for the computer users.
	 2.	 Students must have safe on-line behaviour.
	 3.	 Students may or may not live with school ICT policy.
	 4.	 Computer virus is never harmful to your computer.
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Multiple Choice Questions
	 1.	 Which of the following is/are included in the responsible behavior in the Computer Lab?
		  (a)	 Never share your password, even with your best friend
		  (b)	 Listen to directions given by your computer teacher
		  (c)	 Only use the Internet as instructed
		  (d)	 All of these
	 2.	 Which of the following must be included for implementing the school ICT policy?
		  (a)	 All pupils have equal access to ICT according to their needs
		  (b)	 Gender issue not handled
		  (c)	 No support for gifted students
		  (d)	 Assessment of students not required
	 3.	 Which of the following is not an antivirus?
		  (a)	 Norton	 (b)	 Spamming	 (c)	 Avast	 (d)	 AVG
	 4.	 Which of the following is not a safety rule to protect against viruses?
		  (a)	 Do not open unsolicited e-mails
		  (b)	 Never download an attachment to an e-mail without scanning it for viruses first
		  (c)	 Never use a firewall
		  (d)	 Do not download free software or music

Match the Following

Column A Column B

1. 	Information and computer security (a) Antivirus
2. Computer Lab (b) A big concern for the computer users
3. School ICT policy (c) A place where students must behave in a calm manner
4. Quick Heal (d) Rules prepared by the school and students must live 

with it

Answer the Following
	 1.	 Explain about the responsible behaviour in the computer laboratory.
	 2.	 What is safe on-line behaviour? Explain.
	 3.	 What is school ICT policy? Explain.
	 4.	 Describe computer virus and the measure to protect computer virus.

Suggested Activities
	 1.	 Explain and demonstrate school ICT policy.
	 2.	 Discuss what a computer virus can do to a computer system and demonstrate the measure to protect 

the computer.

Field Trip
	 Students should visit some big educational organization in their city. Interact with faculties there and 

prepare a report on “Information and Computer Security”. Discuss it in the class also.
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Application 
Software

   Unit Outcome
	 Students will be able to:

	 	 recognize the uses of spreadsheets;

	 	 understand the screen elements in the spreadsheet window;

	 	 recognize how to create and use simple spreadsheet using text and numbers;

	 	 understand how to format worksheets;

	 	 recognize to use built in functions and create custom formula.

4.1 spreadsheets

l Introduction
A spreadsheet is a document which helps you organize data in rows and columns that intersect to 
form cells.
	 The electronic spreadsheet is the brain child of Dan Bricklin and Bob Franktor. Behind the invention 
of first electronic worksheet VisiCalc (Visible Calculator) was this duo. Bricklin, a Harvard Business 
school student, got the idea of VisiCalc while spending hours manually to solve financial-planning 
problems.

Purpose of a Spreadsheet
A spreadsheet package is a numeric data analysis tool, which not only allows us to quickly calculate 
and analyse numbers, but also lets us quickly explore a variety of possible outcomes. The spreadsheet 
allows users to create tables and financial schedules by entering data and formulae into rows and columns 
arranged as a grid on a display screen. Some examples of spreadsheets are Microsoft Excel, Corel 
Quattro Pro, OpenOffice Calc, Google Spreadsheets, Lotus-123 etc.

l Starting Spreadsheets
MS-Excel 2007 is a GUI based spreadsheet package that is part of Microsoft Office 2007 suite of 
software. It is a powerful spreadsheet package that supports data of various formats, pictures, 
graphs and drawing objects. There are 1,048,576 rows and 16,384 columns in an Excel worksheet. 
It has got many user friendly features that makes it the first choice of its users.
	 Suppose you are having MS-Excel 2007 installed on your computer. To start MS-Excel 2007 
perform the following:

Unit 4   
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	 Double-click on the MS-Excel 2007 icon on the desktop.
OR

	 Click Start → All Programs → Microsoft Office → Microsoft Office Excel 2007 (see Fig. 4.1).

Fig. 4.1: Starting MS-Excel 2007

l Screen Elements of Spreadsheets
A spreadsheet is a collection of rows and columns. It is also known as a worksheet. A worksheet 
is a primary document to store data.
	 On starting spreadsheet i.e., MS-Excel 2007, a spreadsheet window appears. Screen elements of 
Excel spreadsheet are shown in Fig. 4.2.

Fig. 4.2: Screen elements of Spreadsheet-Excel 2007
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	 Some important screen elements are discussed below:
	 Office Button: Clicking on the Office Button displays a drop down menu containing a number 
of options, such as New, Open, Save, and Print. The options in the Office Button menu are very 
similar to those found under the File menu in previous versions of Excel.
	 Title Bar: This shows the name of the workbook (a collection of worksheets).  
	 Quick Access Toolbar: This customizable toolbar allows you to add frequently used commands. 
Click on the down arrow at the end of the toolbar to display the toolbar’s options. 
	 Formula Bar: Located above the worksheet, this area displays the contents of the active cell. It can 
also be used for entering or editing data and formulas in the active cell. 
	 Name Box: Located on the left of the formula bar, the Name Box displays the cell reference or 
the name of the active cell. 
	 Ribbon: The Ribbon is the strip of buttons and icons located above the work area in Excel 2007. 
The Ribbon replaces the menus and toolbars found in earlier versions of Excel.
	 Sheet Tab: Switching between worksheets in an Excel 2007 file is done by clicking on the sheet 
tab at the bottom of the screen.
	 Status Bar: This shows the status of the active worksheet.
	 Worksheet: This stores the data. 
	 Active Cell: It is the cell with the black outline. Data is always entered into the active cell. The 
cell address is (column letter, row number)
	 1.	 There are screen similarities between MS-Excel, MS-Word and other MS products. The 

main differences in a spreadsheet are:
			   (i)	 the formula bar which is used for operations on cells such as calculations
			  (ii)	 the working area
	2.	 Formula bar is only present in Excel. MS-Excel 2007 has panels in place of menus available 

in earlier versions of Excel.

l Create and Use a Simple Spreadsheet

Creating a Worksheet
To create a worksheet, perform the following steps:
	 1.	 Click the Office Button.
	 2.	 Click the New option (see Fig. 4.3).

Fig. 4.3: Selecting new option
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	 3.	 Double click the Blank Workbook or click on the Create button (see Fig. 4.4).

Fig. 4.4: Double clicking the blank workbook

		  A new worksheet is created (see Fig. 4.5).

Fig. 4.5: A newly created worksheet

	 Cells are the basic working unit on a spreadsheet. These fall at the intersection of each column and row. 
They are referred to by their coordinates, or cell address. A cell’s address is its column letter followed by 
its row number i.e., (column letter, row number). For example, the address of the cell at the intersection of 
column A and row 1 is cell A1 as shown in Fig. 4.5. It is also the active cell.

Using a Spreadsheet
Each cell in a spreadsheet can contain words, a number, or a formula. Data is always entered in the active cell 
and at one time only one cell can be active. Now, you can use the spreadsheet as per your requirement.

	Fill Handle is a small black dot or square in the bottom right corner of the active cell. The fill handle 
has a number of uses including copying a cell’s contents to adjacent cells or to create a series.
	If Excel recognizes the cell contents as part of a series it will Auto Fill other selected cells with the next 
items in the series. Use the fill handle by clicking on it with the mouse pointer to drag select adjacent 
cells.

l Entering and Editing Text
Entering Data
To enter data,
	 1.	 Select the cell where the data has to be added.
	 2.	 Type the data. To enter data in active cell, type the characters. Either press Tab key to go to the next 

cell in the same row or press Enter key to go to the next cell in the same column.
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		 After entering the data, the worksheet may look as shown in Fig. 4.6.

Fig. 4.6: Entering data in a worksheet

Drag Select is a method used to select a range of cells. To do so, click on a cell with the left mouse 
button and, without releasing the button drag the pointer over a block of cells. Release the mouse 
button once the correct block, or range of cells has been selected.

Editing Data

To edit data (in case we have made mistakes or some changes are required),
	 1.	 Double-click the cell, which has to be edited.
	 2.	 Use the arrow key if necessary then press Backspace or Delete key to edit the content of the cell.
	 3.	 Press the Enter key.

OR
	 1.	 Select the cell, which needs to be edited.
	 2.	 Click the Formula bar.
	 3.	 Use the Backspace or Delete key to edit the content of the cell.
	 4.	 Press the Enter key.	

Formatting Spreadsheet

Formatting refers to the act of changing the appearance of data in cells. Data in MS-Excel can be grouped 
into two broad categories: text and numbers. Different formatting options are available for these two 
categories of data. Excel allows many formats for numeric data, for example, general number, positive 
number, decimal number and its precision, currency etc.
	 For textual data, Excel allows you to change fonts, colors, sizes and other features. Excel has a complete 
dialog box for formatting cells.

Inserting Columns, Rows and Cells
MS-Excel 2007 provides an easy way to insert columns, rows or cells.
	 To insert a column,
	 1.	 Open an existing worksheet (refer to Fig. 4.6). Select the cell before which you want to insert the 

column.
	 2.	 Select the Insert Sheet Columns option from Insert available in Cells panel of Home tab (see  

Fig. 4.7).
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Fig. 4.7: Inserting a column

	 3.	 On clicking, a column will be inserted (see Fig. 4.8).

Fig. 4.8: Worksheet after inserting a column

	 To insert a row,
	 1.	 Open an existing worksheet (refer to Fig. 4.6). Select the cell before which you want to insert the 

row.
	 2.	 Select the Insert Sheet Rows option from Insert available in Cells panel of Home tab (see Fig. 4.9).

Fig. 4.9: Inserting a row

	 3.	 On clicking, a row will be inserted above the active cell (see Fig. 4.10).

Fig. 4.10: Worksheet after inserting a row
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	 To insert a cell,
	 1.	 Open an existing spreadsheet (refer to Fig. 4.6).
	 2.	 Select the Insert Cells... option from Insert available in Cells panel of Home tab (see Fig. 4.11).

Fig. 4.11: Inserting a cell

	 3.	 On clicking, an Insert dialog box appears. The dialog box has 4 options out of which 2 are Shift cells 
right and Shift cells down. The Shift cells right option shifts the data of the selected cell and all cells 
to the right of the selected cell one position right. The Shift cells down option shifts the data of the 
selected cell and all the data of the cell below the selected cell one position down. Select the desired 
option (see Fig. 4.12). Here, we select the Shift cells down option.

Fig. 4.12: Insert dialog box

	 4.	 Click OK.
	 5.	 A cell will be inserted at the applied location (see Fig. 4.13)

Fig. 4.13: Worksheet after inserting a cell
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Deleting Columns, Rows and Cells
MS-Excel 2007 provides an easy way to delete columns, rows or cells.
	 To delete a column,
	 1.	 Open an existing worksheet (refer to Fig. 4.6).
	 2.	 Select the column to be deleted.
	 3.	 On right clicking the selected column, a shortcut menu appears.
	 4.	 Select the Delete option from the shortcut menu (see Fig. 4.14).

Fig. 4.14: Deleting a column

	 5.	 On clicking, the selected column will be deleted.
	 To delete a row,
	 1.	 Open an existing worksheet (refer to Fig. 4.6).
	 2.	 Select the row to be deleted.
	 3.	 On right clicking the selected row, a shortcut menu appears.
	 4.	 Select the Delete option from the shortcut menu (see Fig. 4.15).

Fig. 4.15: Deleting a row

	 5.	 On clicking, the selected row will be deleted.
	 To delete a cell,
	 1.	 Open an existing worksheet (refer to Fig. 4.6).
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	 2.	 Select the cell to be deleted.
	 3.	 Select the Delete Cells... option from Delete available in Cells panel of Home tab (see Fig. 4.16).

Fig. 4.16: Deleting a cell

	 4.	 On clicking, a Delete dialog box appears. The dialog box has 4 options 
out of which 2 are Shift cells left and Shift cells up. The Shift cells left option 
deletes the data of the selected cell and moves the data of the cells to its 
right one position left. The Shift cells up option deletes the data of the 
selected cell and moves the data of the cells below it one position up. 
Select the desired option (see Fig. 4.17). Here, we select the Shift cells up 
option.

	 5.	 Click OK.
	 6.	 The selected cell will be deleted.

l Saving the Worksheet
For saving a worksheet the first time,
	 1.	 Click the Office Button.
	 2.	 Click the Save As option.
	 3.	 Click the Excel Workbook option. A Save As dialog box appears (see Fig. 4.18).

Fig. 4.18: Saving a worksheet

	 4.	 Identify the location where the file to be saved and type the name for the worksheet in the File name 
textbox.

	 5.	 Click the Save button.

Fig. 4.17: Delete dialog box
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l Using the Four Mathematical Operators on Data to Create Custom Formula

Formula
A spreadsheet formula is a simple expression created by using operators and cell addresses using 
algebra.
	 In MS-Excel, you can enter numbers and mathematical formulas into cells. Whether you enter a number 
or a formula, you can reference the cell when you perform mathematical calculations such as addition, 
subtraction, multiplication, or division. When entering a mathematical formula, precede with an equal 
(=) sign. Use the following four mathematical operators to indicate the type of calculation you wish to 
perform:
	 +	 Addition
	 –	 Subtraction
	 *	 Multiplication
	 /	 Division
	 For example, = A2 + A3 can be typed in cell A5 (where cells A2 and A3 have data to be added).

l Addition
For addition, perform the following steps:
	 1.	 Create a new worksheet.
	 2.	 Type Add in cell A1. Press Enter key.
	 3.	 Type 2 in cell A2. Press Enter key.
	 4.	 Type 3 in cell A3. Press Enter key.
	 5.	 Type = A2 + A3 in cell A5.
	 6.	 Click the check mark on the Formula bar. Excel adds cell A1 to cell A2 and displays the result in 

cell A5. The formula is displayed on the Formula bar (see Fig. 4.19)

Fig. 4.19: Performing mathematical calculations

Clicking the check mark on the Formula bar is similar to pressing Enter key. Excel records your entry 
but does not move to the next cell.

	 Similarly, you can subtract, multiply and divide the data by using the proper operators (see Fig. 4.19).
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l Sum (dragging)
To find sum by dragging method, perform the following steps:
	 1.	 Type your data and apply sum formula in a cell where you wish to store the result.
	 2.	 Select the cell with the sum formula. 
	 3.	 Activate the formula drag corner. To drag a formula you can easily do so by using the cursor to 

highlight the lower right corner of the cell, where a drag box will appear.
	 4.	 Drag the formula to the new cells. To drag the sum formula across the span of other cells, left-click 

on this drag box and hold as you drag the box to highlight new cells. When you let go off the mouse 
button, the formula will appear in all of the cells that you highlighted when you used the drag box 
(see Fig. 4.20).

Fig. 4.20: Sum by dragging

	 5.	 On pressing Enter key you will get the result (see Fig. 4.21).

Fig. 4.21: Result after dragging

l Entering a Formula into a Cell
As explained earlier, entering a formula is as simple as the other commands of Excel. To enter the formula 
in a cell, click on the cell in which you want to have result of the calculation. Type = sign and write the 
formula using cell addresses and the operators supported by Excel.

Function
A function is a built-in formula that performs calculations on a range of values. It allows you to perform 
mathematical, statistical and date-time functions. For example, Sum, Average, Count, Max, Min etc.
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	 The syntax of writing a function in Excel is:
	 = <Function name>(<List of arguments>)
	 The following examples illustrate the use of functions:
	 = SUM(A2:E2)	 will find the sum (total) of numbers
	 = Average(A2:E2)	 will find the average of numbers
	 Figure 4.22 uses these built-in functions to calculate the total and average.

Fig. 4.22: Using built-in functions

The Auto Sum Feature is used to calculate the sum of the values in a range of cells. This feature adds 
the range of values either above the destination or in the row to the left of the destination cell.
Click on S AutoSum in Formulas tab to use this feature.

l Copying by Using the Fill Handle
Using the fill handle, located in the bottom right corner of the active cell is a quick and easy method of 
copying data, formulas, and functions from one cell to another.
	 To copy data with the fill handle, perform the following steps:
	 1.	 Open a worksheet and type data in it. Here, we have typed Ethiopia in cell A1.
	 2.	 Click on cell A1 to make it the active cell.

Fig. 4.23: Using fill handle for copying after applying bold to a cell

	 3.	 Add bold formatting (Ctrl + B) to the data in cell A1.
	 4.	 Place the mouse pointer over the small black dot in the bottom right corner of cell A1.
	 5.	 The mouse pointer will change to a small plus sign(+) when you have it over the fill handle.
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	 6.	 When the mouse pointer changes to the plus sign, click and hold down the mouse button.
	 7.	 Drag the fill handle to cell A7 to copy the data and the bold formatting to cells A2, A3, A4, A5, A6 

and A7 (see Fig. 4.23).
	 8.	 Cells A1 to A7 now all contain the bold formatted data Ethiopia (see Fig. 4.24).

Fig. 4.24: Worksheet after copying

	 Similarly, you can copy formulas with the fill handle.

Copying formulas to other cells only works if the formula is created using cell references.

Activity 4.1
Adding Background to a Worksheet, Formatting Cells, Numbers, Alignment, Font, 
Borders and Pattern

In small groups students will discuss “Formatting of Worksheet” to make screen displays more readable and 
attractive.
For formatting a worksheet, perform the following steps:
	 1.	 Open a worksheet.

	 2.	 Type the data you wish to format (see Fig. 4.25). 

Fig. 4.25: Worksheet to be formatted
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	 3.	 Now apply the formatting required i.e., Adding background, Formatting cells, Numbers, Alignment, Font, 
Borders and Pattern. Doesn’t the worksheet look really attractive! (see Fig. 4.26).

Fig. 4.26: Worksheet after formatting

	   Key concepts
	 	 A spreadsheet is a document which helps you organize data in rows and columns that intersect to form 

cells.

	 	 In a spreadsheet each cell can contain words, a number, or a formula.

	 	 Some examples of spreadsheets are Microsoft Excel, Corel Quattro Pro, OpenOffice Calc, Google Spreadsheets 
and Lotus–123 etc.

	 	 MS-Excel has screen similarities with MS-Word and other MS products; main differences in a spreadsheet 
are

		  (i)	 the formula bar which is used for operations on cells such as calculations

		  (ii)	 the working area.

	 	 A function is a built-in formula that performs calculations on a range of values. Some examples of functions 
are Sum, Average, Count, Max, Min.

Review Questions
Fill in the Blanks

	 1.	 ........................... is a GUI based spreadsheet package that is a part of MS-Office 2007 suite of software.

	 2.	 In Excel, Title Bar shows the name of the ........................... .

	 3.	 The ........................... is a small black dot or square in the bottom right corner of the active cell.

	 4.	 In MS-Excel, we can use some ........................... to calculate totals and averages.
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State Whether True or False
	 1.	 The electronic spreadsheet is the brain child of Dan Bricklin and Bob Franktor.
	 2.	 In a spreadsheet each cell cannot contain words, a number, or a formula.
	 3.	 In MS-Excel, we can adjust either freehand or using Cells panel of Home tab to insert rows and columns 

and delete rows and columns.
	 4.	 In MS-Excel we cannot apply different effects to a cell and its contents.

Multiple Choice Questions

	 1.	 Which of the following is application software?
		  (a)	 Operating System	 (b)	 Compiler	 (c)	 Interpreter	 (d)	 MS-Excel
	 2.	 Which of the following is the basic unit of data entry in MS-Excel?
		  (a)	 Worksheet	 (b)	 Workbook	 (c)	 Cell	 (d)	 Row
	 3.	 Which of the following is only found in MS-Excel?
		  (a)	 Formula Bar	 (b)	 Quick Access Toolbar	 (c)	 Office Button	 (d)	 Format Painter
	 4.	 Which of the following function will you use to calculate the average of data range?
		  (a)	 SUM( )	 (b)	 AVERAGE( ) 	 (c)	 MAX( )	 (d)	 MIN( )

Match the Following

Column A Column B

1. MS-Excel 2007 worksheet (a) Adds all the numbers in a range of cells
2. Formula bar (b) Used to copy a cell’s contents to adjacent cells or 

to create a series
3. Fill handle (c) Contains 1,048,576 rows and 16,384 columns
4. SUM(  ) function (d) Displays the contents of the active cell

Answer the Following
	 1.	 What is a spreadsheet? Give its purpose and examples.
	 2.	 How will you create and save worksheet in MS-Excel? Explain the steps.
	 3.	 Explain the insertion and deletion of columns, rows and cells in Excel.
	 4.	 What are built-in functions in Excel? Explain SUM and Average functions.

Suggested Activities
	 1.	 Explain and demonstrate the features of spreadsheet.
	 2.	 Explain and demonstrate how to calculate sum(total) using auto sum.
	 3.	 Explain and demonstrate formatting text and numbers in a cell.
	 4.	 Explain and demonstrate cell reference: Absolute and Relative.

Field Trip
	 Using the Internet or computer magazines, look up information on MS-Excel 2010. List any features you 

find. List which of these features appeal to you and describe why they do.
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Using internet

   Unit Outcome
	 Students will be able to:

	 	 understand the Internet as a global network;

	 	 recognize the meaning of some basic terms related to the Internet;

	 	 recognize the work with a search engine to search for items;

	 	 understand hotspots and hyperlinks;

	 	 comprehend the meaning of some common e-mail terms.

5.1 using internet

A computer network is defined as an interconnected collection of computers. A network can either 
be a small group of two or more computers linked together or a high-end network that links 
hundreds or even millions of computers across the globe. Internet is a vast ocean of information. It 
is very useful network. You will study about the Internet in this unit.

l Definition of Internet
Internet is the network that is available to users across the globe (see Fig. 5.1). It is called “the mother 
of all networks”.

OR
	 Internet is the network that contains other networks of computers around the globe into one 
seamless network (see Fig. 5.1). These networks link educational, commercial, nonprofit and military 
entities, as well as individuals.

Fig. 5.1: Internet—the mother of all networks

Unit 5   
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l Uses and Services Available on the Internet
The major use of Internet is for searching the information stored in millions of computers of the 
Internet. Whether you are a doctor, an engineer, teacher, student or businessman; the Internet can 
keep you update about the latest issues in your field and the past issues already occurred. You can 
search for the information, take part in on-line test, audio or video conversation or you can share 
the information with the other users of the Internet.
	 The Internet has given a boom to ‘Information and Communication Technology (ICT)’. Today 
the world of the Internet permits services hardly imaginable 20 years ago. Table 5.1 provides the 
uses and services provided on the Internet.

Table 5.1: The Main Uses and Services Provided on Internet

Activity Purpose

Auctions Sell old stuff, acquire more stuff, with online auctions.

Career advancement Search job listings, post resumes, interview online.

Distance learning Attend online lectures, have discussions, research papers.

Download files Get software, music, and documents such as e-books.

E-mail and discussion groups Stay in touch worldwide through electronic mail and online chat rooms.

Entertainment Amuse yourself with Internet games, music and videos.

E-business Connect with coworkers, buy supplies, support customers.

E-shopping Price anything from plane tickets to cars, order anything from books to 
sofas.

Financial matters Do investing, banking and bill paying online.

News Stay current on politics, weather, entertainment, sports and financial 
news.

Research and information Find information on any subject, using browsers and search tools.

Telephony and conferencing Make inexpensive phone calls; have online meetings.

Who Governs the Internet?
You will be surprised to know that there is no one who owns or runs the Internet. Every subnetwork 
of Internet is responsible for maintenance of its own part and does not bother about the other one. 
The Internet is coordinated by many volunteer organisations and no single organisation is having the 
complete control over it.

l Terms
World Wide Web (WWW) is a set of programs, standards and protocols that allows the text, images, 
animations, sounds, videos to be stored and accessed and linked together in the form of websites. Basically, 
WWW is a collection of millions of web pages stored in thousands of computers all over the world. It is a 
safe house for storing information on the Internet.
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Fig. 5.2: Web inventor: Tim Berners-Lee

	 Remember that the Internet and the World Wide Web are not the same thing. The Internet is a massive 
network of networks, connecting millions of computers via protocols, hardware, and communications 
channels. The Web is a means of accessing information available on the Internet using software called a 
browser.
		 Let us discuss some of the important terms associated with WWW:

Website
A computer with a domain name is called a website (site). The top-level domains are .com, .edu, .org, and 
.net. When you decide to buy books at the online site of a bookseller, you would visit its website. The 
website is the location of a web domain name in a computer somewhere on the Internet.
	 Each website has a unique address.

Web Page
A website is composed of a web page or collection of related web pages. A web page is a document on the 
World Wide Web that can include text, pictures, sound and video. The first page you see on a website 
is like the title page of a book. This is the home page, or welcome page, which identifies the website and 
contains links to other pages at the site.
	 If you have your own personal website, it might consist of just one page—the home page. Large websites 
have many pages.

The contents of home pages often change. Or they may disappear, and so the connecting links to them 
in other web pages become links to nowhere.

Browser
Browsers are software for connecting with websites. A web browser, or simply browser, is software that 
enables users to locate and view web pages and to jump from one page to another. It is what you use to 
get around the web. A web browser makes it easy to navigate (or “surf”) the web and to download items. 
For example, Internet Explorer, Mozilla Firefox, Google Chrome, etc.

l Types of Browsers Software
To use the Web, the software you use is a browser. This is an intensely competitive field right now and browsers 
are undergoing very rapid changes. Some are independent software programs such as those developed by 
Microsoft and Mozilla. Others are integrated into application programs such as word processing programs, 
spreadsheets and databases.
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	 Some of the best-known browsers are:

Internet Explorer
Internet Explorer is one of the most popular web browsers (see Fig. 5.3).

Fig. 5.3: Internet Explorer

Mozilla Firefox
Mozilla Firefox browser is coming up very fast i.e., its users are increasing everyday (see Fig. 5.4).

Fig. 5.4: Mozilla Firefox browser

Google Chrome
Google Chrome is providing a tough fight to other web browsers and is very popular among users (see 
Fig. 5.5).
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Fig. 5.5: Google Chrome

l Screen Elements of Internet Explorer
Internet Explorer (IE) is one of the most popular web browsers. Before you can use IE to browse the web, 
you must be connected to the Internet. When you are connected to the Internet, you are said to be online.
		 There are three ways to start Internet Explorer:
	 1.	 Choose Start, All Programs, Internet Explorer.
	 2.	 Click the Internet Explorer icon on the Quick Launch bar (on the taskbar).
	 3.	 Double-click the Internet Explorer icon on the desktop.
	 Figure 5.6 shows some screen elements of Internet Explorer.
	 When IE opens, you will see the browser interface that contains the standard Windows components: a 
title bar, a menu bar, a content window and a status bar. It also includes a Standard toolbar and Address bar 
similar to those in the Windows Explorer and My Computer windows.

Fig. 5.6: Internet Explorer browser window
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		 In addition to the Standard toolbar and the Address bar, IE also includes a Links bar and a Radio 
toolbar. Like the toolbars in other Windows programs, you can show, hide, size and arrange the IE toolbars 
to suit your work style.

Address Bar
The Address bar indicates the location of the Web page currently displayed in the content window  
(see Fig. 5.7). This location is also known as Uniform Resource Locator (URL). You can think of a URL as 
the Internet address of a web page. The Address bar also provides a drop-down list of the recently visited 
sites. 

Fig. 5.7: Address bar

To access a web page, you can type its URL in the Address bar and, then, click the GO button (or press 
the Enter key).

Standard Toolbar
The Standard toolbar provides buttons to facilitate navigation, searching, printing and other common tasks. 
You can customise this toolbar to include other buttons—such as cut, copy and paste—and you can delete 
any of the default buttons that you do not commonly use. Figure 5.8 shows the Standard toolbar.

Fig. 5.8: Standard toolbar

History
The history list allows you to quickly return to the page you have recently visited. If you want to return to 
a previously viewed site using Internet Explorer, click on History.

Favorites
One great helper for finding your way is the favorite system, which lets you store the URL or web pages 
you frequently visit so that you do not have to remember and retype your favorite address.
		 If you are at a website you may want to visit again, you click on your Favorites (in Internet Explorer) 
button and choose Add to Favorites. Later, to revisit the site, you can go to the Favorites menu, and site will 
reappear.

l Using Internet
To connect to the Internet, we have to connect our computer to the computer server of Internet Service 
Provider (ISP). ISP’s are companies which provide Internet related services to its users. ISP’s have special 
computers called Internet Servers which are connected to the Internet from one end and to several users from 
the other end. These servers work 24 hours a day, 365 days a year to provide services to their customers. 
You must follow the rules and regulations in the use of Internet (netiquette). In general, netiquette has two 
basic rules:
	 1.	 Do not waste people’s time, and
	 2.	 Do not say anything to a person online that you would not say to his/her face.
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l Browsing Information
The words “Browsing” or “Surfing” are used to describe the process of looking at documents, websites 
and web pages on the Internet. As mentioned earlier you will need to use a Web Browser for this. Many 
people will use Internet Explorer, which is the Microsoft Browser that is supplied with most PCs, but there 
are alternative (some say better) solutions such as Firefox and Google Chrome. 
	 Browsing behaviour differs from person to person. To access a website you can either type the domain 
name (the website address) of the website directly into the address bar or you can use a search engine to 
search for the site using the business name or some other keywords that you know can be found on the 
website.

l Saving Document
After browsing information, it can be saved for future use. For saving a document, perform the following 
steps:
	 1.	 Click on the File menu.
	 2.	 Select the Save Page As (Ctrl + S) option (see Fig. 5.9).

Fig. 5.9: Saving document

	 3.	 The Save As dialog box will appear.
	 4.	 Identify the location where the file to be saved and enter the file name and click Save.

l Saving Images
After getting the images, perform the following steps to save these:
	 1.	 Right click on the image.
	 2.	 A menu appears (see Fig. 5.10).
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Fig. 5.10: Saving images

	 3.	 Select the Save Image As option.
	 4.	 The Save Image dialog box will appear.
	 5.	 Enter the file name and click Save.

l Printing Documents
For printing a document, perform the following steps:
	 1.	 Click on the File menu.
	 2.	 Select the Print (Ctrl + P) option (see Fig. 5.11). 

Fig. 5.11: Printing document

	 3.	 The Print dialog box will appear.
	 4.	 Fill the desired options and click OK.
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l Searching Information
In order to help you locate information easily, there are a number of websites on the Internet that provide 
a search engine (a program that helps to locate information on the Internet). Let us have look at a search 
engine and use it to locate information. First, let us go to the side http://www.google.com/, which offers a 
search engine.
	 In the space provided for the search, you need to enter the word or words that describe the item you 
wish to search for, specify if you want the search to be based on the World Wide Web or Ethiopia tourism 
(see Fig. 5.12) and then press Enter key.

Fig. 5.12: Searching information using Google search engine

	 The result of the search, will be displayed as a list that contains the required information with a short 
description of each site (see Fig. 5.13).

Fig. 5.13: Search Results
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	 The names of the websites are links; you can click them to access the requried page. Now, go ahead 
and find the required information.

Hyperlinks enable you to navigate the Web by clicking words, icons, pictures or other graphics on 
a web page. When you point to a hyperlink, your mouse pointer changes to a pointing hand. At the 
same time, the browser status bar shows you the URL associated with the hyperlink to which you are 
pointing.
Text-based hyperlinks are often underlined or displayed in a different color than the rest of the text on 
a Web page. Graphics-based hyperlinks can be icons, logos, buttons, photographs and so on. Clicking 
a hyperlink is just one way to access a specific URL.

Activity 5.1
To Investigate Four Search Engines (for example AltaVista, Lycos, Google and Yahoo), 
Explaining the Features of Search Engines, and Write a report on the Preferred Search 
Engine, Giving Reasons of its Preference.

In small groups students will investigate four search engines, explain their features and present their report in 
the class.

Search Engine

A search engine is a website that collects and organizes content from all over the Internet. Those who wish to 
locate something would enter a query about what they want to find and the engine provides links to content 
that matches it. For example, AltaVista, Lycos, Google and Yahoo.

Let us investigate these search engines and explain their features:

	 1.	 AltaVista: It is a web search engine owned by Yahoo! (see Fig. 5.14). AltaVista was once one of the most 
popular search engines but its popularity declined with the rise of Google. 

 

Fig. 5.14: AltaVista search engine

		  Key Features: AltaVista provides a free translation service, branded Babel Fish, which automatically 
translates text between several languages. In May 2008, this service was re-branded as a part of Yahoo!



Unit – 5 Using Internet

102	  	 Information Communication Technology — Grade 9 Student Textbook

	 2.	 Lycos: It is one of the oldest search engines (see Fig. 5.15). It was originally developed at Carnegie Mellon 
University to calculate the size of the web using a “spider” robot program that walked around the Internet 
from site to site through page links.

Fig. 5.15: Lycos search engine

		  Key Features: Probably the top reason to use Lycos would not necessarily be for its search results, but 
for its fun features.

	 3.		 Google: This search engine has a great reputation for relevant and thorough search results, and is a good 
first place to start when searching (see Fig. 5.16).

Fig. 5.16: Google search engine

		  Key Features: Google search engine provides at least 22 special features beyond the original word-search 
capability. These include synonyms, weather forecasts, time zones, stock quotes, maps, earthquake data, 
movie show times, airports, home listings, and sports scores.

	 4.	 Yahoo: This is one of the best known and most popular Internet portals. Originally a subject directory of 
sites, it now is a search engine, directory, and portal (see Fig. 5.17).
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Fig. 5.17: Yahoo search engine

		  Key Features: Yahoo has a large and unique search engine database, includes cached copies of pages, 
includes links to the Yahoo! directory, supports full Boolean searching, and includes Wild Card Word in 
Phrase.

Preferred Search Engine

Each search engine competes with other search engines for users, just as online businesses compete with each 
other for customers. This creates a fierce rivalry to provide better results and services for users as they surf the 
Internet

On www.ketteringwebsolutions.co.uk the following definition of Google was given:

“The Internet’s most popular search engine. Can be found at www.google.com”.

The glossary of www.satellite-tv-hq.com/ agrees with above and gives the next Google definition:

“The world’s current dominating search engine.”

These both statements are proved by the next Google definition, made by the free encyclopedia “Wikipedia”:

“Google is a search engine owned by Google Inc. whose mission statement is to ‘organize the world’s information 
and make it universally accessible and useful.’ The largest search engine on the Web, Google, receives over 200 
million queries each day through its various services”. This Google definition formulates the main mission of 
the search engine. The efforts of Google are evident, and it is confirmed by the number of queries, over 200 
million each day. Such activities illustrate this Google definition, as the most popular search engine.

	    Key Concepts
	 	 Internet is the network that is available to users across the globe.

	 	 The major use of Internet is for searching the information stored in millions of computers of the Internet.

	 	 A web browser, or simply browser, is software that enables users to locate and view web pages and to jump 
from one page to another. For example, Internet Explorer, Mozilla Firefox, Google Chrome etc.

	 	 Screen elements of Internet Explorer are: Menu bar, Address bar, Standard toolbar, Workspace, Content 
window, Status bar etc.

	 	 Examples of search engines are AltaVista, Lycos, Google and Yahoo.
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Assessment 5.1
Fill in the Blanks

	 1.	 ...................................... is called “the mother of all networks”.

	 2.	 A computer with a domain name is called a ...................................... .

	 3.	 To use the web, the software you need is a ...................................... .

	 4.	 Google has a ...................................... engine.

State whether True or False

	 1.	 Internet is not a vast ocean of information.
	 2.	 The Internet and the World Wide Web are not the same thing.
	 3.	 Internet Explorer is not a very popular web browser.
	 4.	 There are a number of websites on the Internet, that provide a search engine, which help you locate 

information easily.

Answer the Following

	 1.	 What is Internet? Who governs it?
	 2.	 Explain how Internet and WWW are used?
	 3.	 Define website, webpage and a browser.
	 4.	 List and describe some different types of browser.

Suggested Activities

	 1.	 Explain the difference between a website and web pages; show some sites and pages.

	 2.	 Explain that each website has a unique address; a website holds information; creation of websites briefly; 
there may be a few or many pages on the website.

	 3.	 Explain and demonstrate some hyperlinks, and returning back to the original web page.

Field Trip

	 Students to locate the name and telephone number of a local Internet access provider. Also, get the name, 
telephone number, and e-mail address of their help desk so they can help if you have any questions getting 
connected. Ask the following questions.

		  (i)	 What is the one-time connect charge, if any?
		  (ii)	 What is the monthly charge?
		  (iii)	 How many free hours are there?
		  (iv)	 What is the cost per hour after you exceed the maximum free hours?
		  (v)	 Do they provide an e-mail address?
		  (vi)	 What browser is required? Do you have a choice?
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5.2 using e-mail

E-mail or electronic mail is the exchange of messages stored on computers, through a communication 
channel. E-mail was one of the first uses of the Internet and is still the most popular. To send and receive 
e-mail, you need to create an account with an e-mail service provider. The Internet does not limit you to 
one e-mail address. You can create multiple e-mail addresses. There are many Internet based e-mail service 
providers. For example,

		 http://www.yahoo.com/

	 http://www.hotmail.com/

E-mail offers cheap, reliable, speedy communication with patience and user friendliness. It 
is helpful in reducing the volume of papers in offices. It has completely changed the modern 
communication system.

l Creating an E-mail Account 
As mentioned earlier, to send and receive e-mail, you need to create an account with the e-mail service 
provider. The steps to create an e-mail account on different online service providers are almost similar. The 
process simply involves filling account and personal information. Some steps may be different in different 
service providers like yahoo, rediff, hotmail etc. You are advised to use common sense while creating 
e-mail accounts.
	 Let us use the site http://www.yahoo.com/ to create an E-mail account, i.e., a mail ID (see Fig. 5.18). Go 
ahead and create your e-mail ID by accessing the site,
	 http://www.yahoo.com/

Fig. 5.18: Using the site yahoo.com

OR
	 You can directly open the site by typing http://www.yahoomail.com
	 Since you are a new user, to create a new account, select the ‘Create New Account’ option  
(see Fig. 5.19).
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Fig. 5.19: Selecting the Create New Account option

	 Type in your Name, Gender, Birthday, Country etc., in the spaces provided (see Fig. 5.20).

Fig. 5.20: Typing the details

	 The name that you enter in the Yahoo ID text box is your yahoo mail ID. You can choose any name for 
the ID, but it should be one that you can identify easily. It has to be unique, since two people cannot have 
the same ID. For example, let us assume your name is Senya Ali and you choose Senya_Ali as your ID. If 
there is already another user with the same ID, you will be asked to choose a different ID.

	 Click the ‘Create My Account’ button (see Fig. 5.21).
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Fig. 5.21: Selecting Create My Account

	 On successful creation of the account, a page similar to the one shown in Fig. 5.22 will be displayed.

Fig. 5.22: Ready to explore the created account
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	 Your account is created (see Fig. 5.23).

Fig. 5.23: New User Account Mail box

	 Now you can use your account for sending and receiving mails.

l Composing and Sending an E-mail

Composing an e-mail
Click on the ‘New’ link on the left side of the mail box to compose a new mail.
	 Composing of an e-mail message is done very much like a paper letter. It consists of three parts, the 
header, the body and the signature. The header, at the top of the message, is the envelope, the body is the 
actual message, the signature comes at the end (see Fig. 5.24).

Fig. 5.24: Composing an e-mail

	 You do not have to be online while composing your e-mail messages. E-mail lets you write messages 
offline, so you can save them, then go online, and send them all at once.
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Editing of an e-mail message can be done like editing of text in MS Word. Various editing features like 
font, font size, bold, italic, underline, text color, emoticons, text alignment, bullets, numbering etc. are 
available in the mail box.
Spell checking must be done before sending e-mail messages by the user. You can spell check by 
clicking the Spelling button in the mail box.

Sending an e-mail

First of all compose your e-mail. Now, enter the recipient’s e-mail address in the ‘To’ option. You can send 
copies of the mail to other users by using the ‘Cc’ option. You can enter the contents and addresses in the 
appropriate places provided.
	 Click the ‘Send’ button when you have typed in the message and addresses and you are ready to send 
the e-mail. Make sure that you have spell checked the message before sending it.
	 From the Sent folder, you can view the message sent.

l Receiving and Replying to an E-mail

Receiving an e-mail
To send and receive mails, log on to the site using the Yahoo ID and the password.
	 To read the received mails, click on the Inbox shown on the left side of the screen.
	 On clicking the Inbox you will see the list of received mails. Select anyone of these and click to read it 
(see Fig. 5.25).

Fig. 5.25: Receiving an e-mail

Replying to an e-mail
To reply to an e-mail, use the Reply command icon. After clicking Reply button you will see a screen similar 
to shown in Fig. 5.26, where you can type your reply message.
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Fig. 5.26: Replying to an e-mail

l Facilities of an e-mail System
Now you are familiar with basic concepts of e-mail. So let us understand the facilities of an e-mail system. 
All e-mail systems have the ability to send, receive and discard mail (see Fig. 5.27).

Fig. 5.27: You can send, receive and discard an e-mail

	 Most systems have facilities for storing mail which is to be kept rather than discarded. It is important 
for you to discard mail which does not need to be kept, as it uses storage space on disks. Mailboxes can 
soon accumulate a large number of mail messages making it difficult to read and process new mail, in 
addition to wasting disk space. 
	 There is almost always a connection between the e-mail system and the computer’s standard file system 
which allows mail to be read from files or written to files. This enables greater flexibility in how the mail 
system is used. For example, a mail message may be prepared in a normal file using a familiar text editor 
and then sent by the e-mail system. Sections of other files may be included in the mail message as well. 
	 Most systems have a reply facility, although some of these do not always work as expected. A great 
care should be taken when using this facility in e-mail, as replies do not always go back to the sender. 
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l Distribution List
A distribution list, also known as a mailing list, is a collection of e-mail addresses that allows you to e-mail 
multiple people at one time. A distribution list can contain a few addresses, or many. When you send to a 
distribution list, you are really sending to everyone whose address is included in the list (see Fig. 5.28).

Fig. 5.28: A distribution list makes e-mailing easier

	 By grouping all of the e-mail addresses together, you can address one e-mail to the category name and 
avoid typing each individual’s e-mail address. 
	 Yahoo Mail provides a means of making distribution lists, which Yahoo refers to as “Categories”. 
	 To create a distribution list, perform the following steps:
	 1.	 Open a browser. Here, we have opened Mozilla Firefox.
	 2.	 Type the address www.yahoomail.com into the address bar of your web browser and press Enter 

key. Log into Yahoo if you are not already signed in. This takes you directly to your Yahoo Mail 
address book (see Fig. 5.29).

Fig. 5.29: Yahoo Mail Box
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	 3.	 Click “Contacts” link in the left pane of the window if you are using “Yahoo Mail” or click the 
“Contacts” tab near the top of the window if you are using “Yahoo Mail Classic” (see Fig. 5.30). 

Fig. 5.30: Clicking Contacts

	 4.	 Click the “Add Category” button on the Yahoo Mail toolbar. Type a name (upto 15 alphanumeric 
characters, no spaces) for the distribution list into the “Category Name” box (see Fig. 5.31). You can 
now add contacts to the category. Click “Save.”

Fig. 5.31: Typing Category Name and Clicking Save

	 5.	 Select “View” and click the “All Contacts” button (see Fig. 5.32). Select the check boxes to the left 
of each contact whom you wish to add to the distribution list. Click “Add to Category” in the main 
window.



Unit – 5 Using Internet

	 Information Communication Technology — Grade 9 Student Textbook	 	 113

Fig. 5.32: Selecting View and Clicking All Contacts

	 6.	 Select the check box for the distribution list to which you want to add your contacts. Click the 
“Done” button.

	 1.	 To send an e-mail to your distribution list, click the “View” button and select the list name. Click 
the “Select All” check box. Click “Send e-mail” in the main window and compose your e-mail. 
When you send the message it will be sent to everyone in the list.

	 2.	 You can rename and delete the user-defined categories, but you cannot rename or delete system 
categories.

l Attachments
If a file of your matter exists in the computer from which you are sending e-mail, you can write your e-mail 
message, (your cover note) and then use the Attach link to attach the document. Such attached documents 
may be in MS Word or Excel and are called attachments.
	 While you could also copy your document into the main message and send it that way, some e-mail 
software lose formatting options such as bold or italic text or special symbols. Thus, the benefit of the 
attachment feature is that it preserves all such formatting, provided the recipient has the same software 
that you used for creating the attachment. You can also attach pictures, sounds, videos, and other files to 
your e-mail message.

Sending
To send an e-mail attachment,
	 1.	 Address the person who will receive the attachment.
	 2.	 Write a ‘‘cover letter’’ e-mail or your message advising the recipient of the attachment.
	 3.	 Click on Attach button on your e-mail software’s toolbar.
	 4.	 Select the file you want to attach.
	 5.	 Click on Send to send the e-mail message and the attachment (see Fig. 5.33).

System 
Categories

User-defined 
Categories
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Fig. 5.33: Sending an e-mail attachment

Receiving
When you receive a file containing an attachment, you will see an icon indicating that the message contains 
more than just text. You can click on the icon to see the attachment. If you have the software the attached file 
was created in, you can open the attachment immediately to read or print, or you can save the attachment 
in a location of your choice (on your computer). You can also forward the attachment to another person.

Fig. 5.34: Receiving an e-mail attachment

		 To exit your mailbox, click the ‘Sign Out’ link.
1.	 It is important that the persons receiving the e-mail attachment have the exact same software that 

created the attached file, such as Microsoft Word 2007, or have software that can read and convert 
the attached file.

2.	 Many viruses—those rogue programs that can seriously damage your PC or programs—ride along 
with e-mail as attached files. Thus, you should never open an attached file from an unknown source.

l Auto Reply
Auto Reply feature is useful when you are on holidays and want to inform people that you would not be 
checking your e-mail for a few days. In other words, you may also want to take holidays from e-mail and 
answering it. 
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	 Surely, you will read and reply to all your e-mail when you will be back. Yahoo Mail offers a nice way 
to tell those who send you e-mail during this period that they should not expect an immediate answer.

Auto-Reply in Yahoo Mail
To have Yahoo Mail reply to e-mails automatically, perform the following steps:
	 1.	 Select Options → More Options... in Yahoo Mail (see Fig. 5.35). 

Fig. 5.35: Selecting More Options for Auto Reply

	 2.	 Go to the Vacation Response category. 
	 3.	 Make sure Enable auto-response during your vacation is checked. 
	 4.	 Specify your auto-responder’s start and end date under Auto-respond from and up until (and including) 

respectively. 
	 5.	 Type the desired response you wish to be sent to all incoming mail under Generic Response. 
	 6.	 It is good to include a note on when you expect to be back — and be able to respond personally. 

	 7.	 Click Save Changes. 

Yahoo Mail’s auto-reply system does not know to whom a holiday reply was already sent to, so all 
repetitive mailers will get repetitive replies. May be they deserve it.

	    Key Concepts
	 	 E-mail is the exchange of messages stored on computers, through a communication channel.

	 	 To send and receive e-mail, you need to create an account with an e-mail service provider.

	 	 Composing of an e-mail message is done very much like a paper letter.

	 	 All e-mail systems have the ability to send, receive and discard mail.

	 	 Auto Reply feature is useful when you are on holidays and want to inform people that you would not be 
checking your e-mail for a few days.
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Review Questions
Fill in the Blanks

	 1.	 E-mail was one of the first uses of the ..................... .
	 2.	 You do not have to be ..................... while composing your e-mail messages.
	 3.	 The attached documents (e.g., in MS Word or Excel) with your e-mail message are called ..................... .
	 4.	 A ..................... is a collection of e-mail addresses that allows you to e-mail multiple people at one time.

State Whether True or False

	 1.	 E-mail is not very popular now a days.
	 2.	 To send and receive your e-mail, you do not require an e-mail account.
	 3.	 You can attach pictures, sounds, videos, and other files to your e-mail message.
	 4.	 Auto Reply is not a useful feature during your holidays.

Multiple Choice Questions
	 1.	 Who owns the Internet?
		  (a)	 No one owns the Internet	 (b)	 Microsoft 	 (c)	 IBM	 (d)	 U.S. government
	 2.	 A location on the Internet is called a/an ...................................... .
		  (a)	 User ID	 (b)	 Domain	 (c)	 Browser	 (d)	 Web
	 3.	 Which of the following is/are e-mail service provider(s)?	
		  (a)	 Yahoo	 (b)	 Gmail	 (c)	 Hotmail	 (d)	 All of these
	 4.	 A distribution list is also known as a ...................................... .
		  (a)	 Mailing list	 (b)	 Auto reply	 (c)	 Attachment	 (d)	 Item list

Match the Following

Column A Column B
1. Browsing (a) Search engine
2. AltaVista (b) Also known as surfing
3. E-mail systems (c) 	Can be used when you are on holidays 
4. Auto Reply (d) Have the ability to send, receive and discard mail

Answer the Following
	 1.	 What is e-mail? Give the steps to create an e-mail account.
	 2.	 Give the steps to compose and send an e-mail.
	 3.	 Give the steps to receive and open an e-mail.
	 4.	 Discuss the facilities provided in the e-mail system.

Suggested Activities
	 1.	 Explain why distribution lists are useful and demonstrate how to implement.
	 2.	 Explain and demonstrate how to attach a file to an e-mail, and how to open an attachment on an 

incoming mail.
	 3.	 Open a browser and indicate the following screen elements:
		  Menu bar, Address bar, Standard toolbar, Status bar and Workspace.
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Control and 
learning with logo

   Unit Outcome
	 Students will be able to:

	 	 understand the logo language;

	 	 recognize to produce a variety of diagrams using the logo language.

6.1 control and learning with logo

LOGO (Logic Oriented, Graphics Oriented) is a high level programming language specifically 
designed for its ease of use and graphics capabilities. LOGO was originally developed in 1967 by 
Seymour Papert and a team at Massachusetts Institute of Technology (MIT) in United States.  It was 
originally designed to introduce children to programming concepts, and to help develop better 
thinking skills that could be transferred to other contexts. It is easy to learn, easy to use, easy to 
read, but also powerful and able to cope with complex problems.
	 Logo is so easy that it can be understood by the 7 to 77 years old. Logo’s graphics language 
is called turtle graphics, which allows complex graphics images to be created with a minimum of 
coding. Logo has evolved into a powerful computer language. Logo is considered an interpreted 
language because Logo programs are executed by an interpreter.
	 Some benefits of Logo over other programming languages are:

	 1.	 It fosters (promotes) group collaborative work.

	 2.	 It allows students to visualize mathematical and geometrical concepts.

	 3.	 It teaches students that the computer is a device to be controlled, rather than one that controls.

	 4.	 It introduces students to programming structures and concepts.

	 5.	 It promotes concepts associated with the Technology and Enterprise Learning Area.

	 6.	 It is immediate. There is no waiting while the program is run.

	 7.	 It uses simple ‘English’ commands and is not case-sensitive.

	 8.	 It is graphical in nature.
	 The programming language you will be learning in this Unit is Logo. The version of LOGO that 
we are using is MSW LOGO (Windows based), which is available from Softronics, Inc. as freeware 
on the Internet (http://www.softronix.com).

Unit 6   
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Starting Logo
To start Logo, perform the following steps: 
	 Click Start → All Programs → Microsoft Windows Logo → Microsoft Windows Logo  
(see Fig. 6.1).

Fig. 6.1: Starting LOGO

OR
	 Double click on the MSW Logo shortcut icon on the desktop of your computer (see Fig. 6.2).

Fig. 6.2: MS Logo Shortcut Icon

	 The screen shown in Fig. 6.3 will appear:
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Fig. 6.3: MSW Logo Screen

	 Some MSW Logo screen elements are given below:
	 Title bar: Title bar contains the name of program (MSW Logo).
	 Menu bar: Menu bar contains various options for handling, editing and formatting file. Menu 
titles contain various sub-options which comes when these menu titles are clicked upon.
	 Button bar: Button bar provides additional shortcuts for Logo commands. To execute  a button 
command, position the mouse cursor on the button and press the left mouse button.

Graphics window
Graphics window is the area where the turtle moves around and draws. The Turtle appears in this 
area.

Listener window
Listener window is the area where the commands are typed. You will see small question marks(?) 
in this area.

The turtle moves on the screen according to the commands given. It understands only LOGO 
commands. Centre of the screen is the home of the turtle.

l Using Primitives
When you load Logo, a triangular shape pointer appears at the centre of the screen called Turtle. 
It has a pointing tip. Turtle indicates that position on the screen, from where the drawing will 
start. In other words, we can say that turtle is a point of invisible pen, that helps in drawing 
figures. The home position of turtle is in the centre of the screen, where it appears in the beginning. 
The primitives are typed in the white space at the bottom left corner of the screen known as the 
Command Input Box.
	 The first step to learn any drawing is to know about drawing a line. Therefore, you will read 
about some primitives which are useful in drawing lines and boxes.
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Forward (FD)
This primitive moves the turtle in the forward direction with the number of steps mentioned with 
the primitive. The turtle draws a line while moving. For example, to draw a line of 40 steps type 
the following command in the Input Box.

Command Result

FD 20 ↵ (Here, ↵ means press Enter key) ↑ (a line of 20 steps)

FD20 ↵ I don’t know how to FD20

Forward 50 ↵ ↑ (a line of 50 steps)

FD ↵ not enough inputs to FD

Forward50 ↵ I don’t know how to forward50

Back (BK)
Turtle moves backward and draws a line of specified number of steps.
	 The turtle moves in the direction, where it has its back.
	 It is just like driving a car in reverse (back) gear.
	 For example, to draw a line of 50 steps in backward direction, type the following command in the Input 
Box.

Command Result

BK 60 ↵ (Here, ↵ means press Enter key)  (a line of 60 steps)

BACKWARD60 ↵ I don’t know how to Backward60

BK40 ↵ I don’t know how to BK40

BK ↵ not enough inputs to BK

BK 50 ↵  (a line of 50 steps)
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	 1.	 LOGO commands are known as the ‘Primitives’. 
	 2.	 LOGO is not case-sensitive, that is, upper-case letters are not distinguished from lower-case letters.
	 3.	 BYE primitive is used to exit LOGO.

Turning the Turtle

Turtle can be turned in right (clockwise) or left (anti-clockwise) direction by using RT (Right) or LT (Left) 
primitives.

Right (RT)

To turn the Turtle in right or clockwise direction, use RT/RIGHT primitive. It needs number of degree to 
know the angle of turn. For example,

Left (LT)
To turn the Turtle towards left or in anti-clockwise direction, use LT/LEFT primitive. It needs number of 
degree to know the angle of turn. For example,

We can move the turtle forward, backward, right and left on the screen.

Home

Turtle always rests in the centre of the screen which is known as its home. From here, the turtle moves 
around the screen.
	 HOME primitive sends the turtle in the centre of the screen. The Home primitive is not followed by 
any number. The turtle draws a line as it goes back to its home and faces upwards in its home position. 
For example,
	 Type the following commands in the Command Input Box to see the output shown on right side:
		  FD 100 ↵

		  RT 90 ↵

		  FD 100 ↵

		  Home ↵
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Hide Turtle (HT)
When this command is entered, the turtle disappears from the screen.
	 Turtle follows all the commands and can draw anything even though it is not seen on the screen. For 
example,

	1.	 No space(s) is/are required within a primitive. If you give space, error message appears.
	2.	 To use more than one primitive at a time, we must leave a space in between them.

Show Turtle (ST)
ST command brings the turtle back on the screen, which had disappeared using HT command. For 
example,

Clear Text (CT)
It clears the Text Area.
	 All the commands disappear from the Listener window. For example,
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Clear Screen (cs)
CS command clears the Graphics area. For example,

Clean command clears the entire drawing from the screen but leaves the turtle at its last position.

Pen Up (PU)
As you lift your pencil up when you want to leave some gap between the two words while writing, so is 
the case with the turtle.
	 To move the turtle without drawing a line PEN UP primitive is used. There is no need to give any 
number after Pen Up command. For example, to draw the two lines shown on left, type the commands 
shown on right side.

	 In the above example, we have used PD command, let us see why this command has been given.

Pen Down (PD)
You cannot draw till you put your pencil down. The same way, turtle starts drawing again only when 
you give PEN DOWN (PD) command. There is no need to mention any number after PD command. For 
example,
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Pen Erase (PE)
The turtle can erase a line on which it moves. For this PEN ERASE (PE) primitive is used. You need to move the 
turtle on the lines you want to remove/erase after giving PE command. For example,

	 To erase a line of 10 steps so that this figure can become a square of 40 steps, give the following 
commands:

	 To bring your turtle in the normal mode again, give PE command so that you can complete your figure 
after correcting the mistake.

Using the LOGO primitives to draw a variety of shapes
Now, you are familiar to LOGO primitives. So, let us use these primitives to draw a variety of shapes:
	 Example 1: Draw an equilateral triangle of side 100 steps, using the LOGO primitives.
	 Type the following commands in the Command Input Box to draw an equilateral triangle of side 100 
steps:
		  FD 100 ↵

		  RT 120 ↵

		  FD 100 ↵

		  RT 120 ↵

		  FD 100 ↵

		  RT 120 ↵

	 Example 2: Draw a circle of radius 80 using the LOGO primitives.
	 Type the following command in the Command Input Box to draw a circle of radius 80 with the turtle 
at the centre of the circle:

           ARC 360 80 ↵

                  OR

            CIRCLE 80 ↵
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 	 Type the following command in the Command Input Box to create a circle of radius 80 with the turtle 
at the edge of the circle:

	   CIRCLE2 80 ↵

 
	 Example 3: Draw a square of side 60 steps, using the LOGO primitives.
	 Type the following commands to draw a square of side 60 steps:

Print Command
print/pr primitive is used to display a letter, number, word or a sentence on the screen. It can also 
be used for doing calculations. This command takes only one input at a time and displays the output in 
Recall List Box. For example,

		  Print 2011 ↵

will print 2011 in the Recall List Box.

	 Use “ before a letter/word and enclose a sentence in “ “ or [ ].

Repeat Command
Repeat primitive is used when same set of commands are to be given again and again. Instead of 
typing same set of commands repeatedly, they can be clubbed up in a single line Repeat command. For 
example, to draw a square of side 60 steps, type the following command:

	  Repeat  4 [FD 60 RT 90] ↵

	       OR

	  Repeat  4 [FD 60 RT 360/4] ↵
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	 Here, the number 4 after the Repeat primitive, tells the computer to repeat four times whatever 
command is given within the square bracket.
	 The structure of Repeat command is:

	  Repeat 
No. of times

the commands are
to be repeated

No. of turtle steps in
each line direction and
the angle by which
turtle turns each time

J

L

K
K
KK

N

P

O
O
OO

	 Now, type the following command in the Command Input Box to draw the regular polygons (pentagon 
and hexagon) by using the Repeat command:

	 Repeat  5[FD 100 RT 72] ↵   

	 Repeat  6[FD 100 RT 60] ↵  

For an N side regular polygon, the Turtle will turn by 360/N degrees.

l Writing Procedures Using Random

To write a procedure in Logo is to teach the turtle how to draw something. Let us learn about the 
procedures in Logo:

Procedures

Procedures are the heart of LOGO and other programming languages. Procedures are small programs that 
can be called on again and again through one word and without typing them all out.
	 The structure of a procedure in LOGO is:
	 To Procedurename

	  Steps of the procedure 
	 End

	 A procedure must start with the word To, followed by a name you give. Then come all the steps you 
would write on the command line. A procedure must end with the word End.
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	 Remember the following points while writing procedures in logo:
	 1.	 You must avoid use of logo commands as procedure names!
	 2.	 Procedure name can have letters, numbers and symbols.
	 3.	 The first character in procedure name should always be a letter.
	 4.	 Blank space and arithmetic operators are not allowed in the procedure name.
	 5.	 You can use small or capital letters or a mixture of these for a procedure name.

Commands having a semicolon (;) in front are called comments which are ignored by MSW Logo.

Random Command 

LOGO provides one of the best ways of stimulating children in their work by using the RANDOM command. 
The command RANDOM is usually followed by a number. For example, 
	 RANDOM 15 ↵
would generate a random integer number less than 15.
	 Type the following and see the output:
	 Repeat  5 [Show Random  100] ↵

How do you write a procedure in LOGO?
A LOGO procedure can be written in the following ways:
	 1.	 Using the Input Box (see Fig. 6.4), which can be opened 

by typing in To followed by the Procedure Name in the 
Command Input Box.

	 2.	 Using the Editor window (see Fig. 6.5), which can be opened 
by any one of the following:

	 (i)	 Clicking the Edall button on the Button bar 
	 (ii)	 Using the Edit option in the File menu
	 (iii)	 Typing “Edit Procedure Name in the Command Input Box (do not forget quotation mark before 

Procedure Name).

Fig. 6.5: Editor window

Fig. 6.4: User Input Box
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	 Let us write a simple procedure SQUARE in LOGO, using the Input Box, to draw a square of side of 
length 50.
	 To code, run and save the procedure, perform the following steps:
	 1.	 Click the Input Box.
	 2.	 Type in TO followed by the name of the procedure, here we type, TO SQUARE.
	 3.	 Press the Enter key. The user Input Box appears.
	 4.	 Enter the set of instructions one after other for drawing a square. Press the Enter key after each 

line.
	 5.	 When all the instructions have been entered, type in END and press the Enter key. Your Procedure 

SQUARE has been defined. The entered procedure code is shown below:
			   TO SQUARE
			   ; Procedure SQUARE 
				    CS          ; Clear Screen
				    REPEAT 4 [FD 50 RT 90] 
				    HT          ; Hide Turtle
			   END 
	 6.	 To run the procedure, type SQUARE in the Command Input Box and press the Enter key.
       		  This draws a square of side length 50 on the graphics screen as shown below:

	 7.	 To save the procedure, click on the Input Box to make it active and type:
			   SAVE “SQUARE. 

The file saved in LOGO will have an extension .LGO. Type Load “Procedure Name to recall a saved 
procedure.

	 In LOGO, you can put a procedure within REPEAT command or within another procedure. Let us write 
procedures to include REPEAT and RANDOM command:
	 Example 1: Write a procedure to draw a simple star shape using REPEAT command.
		  TO STAR
		  ; Procedure STAR
		       CS   ; Clear Screen
			   REPEAT 10 [LT 60 FD 50 RT 120 FD 50 LT 60 RT 36] 
			   HT   ; Hide Turtle 
		  END
	 Type the following in the Command Input Box and press the Enter key to run the procedure:
           STAR
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	 This draws a star on the screen as shown below:

	 Example 2: Write a procedure to draw circles randomly using RANDOM command.

		  TO DRAWCIR

		  ; Procedure DRAWCIR to draw circles randomly

			   CS  ; Clear Screen

				   REPEAT 10 [CIRCLE RANDOM 100]

			   HT   ; Hide Turtle 

		  END

	 Type the following in the Command Input Box and press the Enter key to run the procedure:

		  DRAWCIR 

	 This will draw circles randomly on the graphics screen as shown below:

Your output may be different every time when you run the LOGO procedure(s) having Random 
command(s).

	 Example 3: Write procedure(s) to draw squares randomly using RANDOM command.

		 Let us write a procedure SQUARE1 first and then use it in another procedure RSQUARES to draw 
random squares:
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		  TO SQUARE1

		  ; Procedure SQUARE1

		 	   REPEAT 4 [FD 40 RT 90] 

		       HT          ; Hide Turtle

		  END 

		  To RSQUARES

		  ; Procedure RSQUARES
 	     		 CS ; Clear Screen
			   REPEAT 30[SQUARE1 PENUP RT RANDOM 360 FD RANDOM 50 PENDOWN]
		  END
	 Type the following in the Command Input Box and press the Enter key to run the procedure:
		  RSQUARES
	 This will draw random squares on the screen, lifting the pen and moving it to a random location before 
drawing another square as shown below:

Type Erase “Procedure Name and press Enter key to erase a procedure. The Erase All command 
erases all the procedures.

Activity 6.1
Draw a Variety of Shapes using the LOGO Primitives and Procedures

Students in small groups will use the LOGO primitives and procedures to draw a variety of shapes. The group 
leader from each group will give a brief presentation to the class based on it.

Logo Primitives 

The Logo Primitives are basic Logo Commands.

Procedures

Procedures are small programs that can be called on again and again through one word and without typing 
them all out.
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Drawing Shapes using Primitives and Procedures

We can draw various shapes in LOGO using the CS, FD, LT, RT, HOME, HT primitives and procedures. For 
example,

Shape LOGO Procedure to Draw the Shape

A Scalene Triangle TO Scalene

; This procedure will draw a scalene triangle
CS
FD 100
RT 150
FD 50
HOME
HT

END

An Isosceles Triangle TO Isosceles

; This procedure will draw an isosceles triangle

CS
RT 20
FD 100  
RT 140
FD 100
HOME
HT

END

An Equilateral Triangle TO Equilateral

; This procedure will draw an equilateral triangle

CS

FD 100  

RT 120

FD 100  

RT 120

FD 100  

HT      

END

A Rectangle TO Rectangle

; This procedure will draw a rectangle

CS

REPEAT 2[FD 100 RT 90 FD 50 RT 90]  

HT       

END
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A Square TO Square 

; This procedure will draw a square

CS

REPEAT 4[FD 100 RT 90]  

HT 

END

	    Key Concepts
	 	 LOGO stands for Logic Oriented, Graphics Oriented.

	 	 MSW LOGO screen is divided in two parts—Graphics window and Listener window.

	 	 CS primitive clears the graphics screen.

	 	 We can write a procedure in two ways using the “Input Box” or using the “Editor window”.

	 	 Procedures are small programs that can be called on again and again through one word without typing them 
all out.

	 	 The file saved in LOGO will have an extension .LGO.

	 	 BYE primitive closes the LOGO.

Review Questions
Fill in the Blanks
	 1.	 LOGO was developed by ...................... and his team.
	 2.	 When you load Logo, a triangular shape pointer appears at the centre of the screen called .................... .
	 3.	 The ...................... primitive moves the turtle in forward direction.
	 4.	 The ...................... primitive turns turtle’s face on left side.

State Whether True or False
	 1.	 Logo is a high-level programming language.
	 2.	 Logo is considered an interpreted language because Logo programs are executed by an interpreter.
	 3.	 The BK primitive turns turtle face on right side.
	 4.	 The ST primitive shows the turtle again.

Multiple Choice Questions

	 1.	 All the figures are drawn by ...................................... in LOGO.
		  (a)	 Turtle			   (b)	 Hand
		  (c)	 Bye			   (d)	 Print
	 2.	 Which of the following LOGO primitive moves the turtle’s face in right side?	
		  (a)	 ST			   (b)	 HOME
		  (c)	 PD			   (d)	 RT
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	 3.	 Which of the following LOGO primitive moves the turtle in backward direction?
		  (a)	 FD			   (b)	 BK
		  (c)	 HT			   (d)	 BYE
	 4.	  A set of LOGO commands referred by a name, which is given to perform a particular task is called a .

..................................... .
		  (a)	 Operator			   (b)	 Procedure
		  (c)	 Action			   (d)	 Random

Match the Following

Column A Column B

1. 	Graphics window in LOGO (a) 	Generates a random integer number

2. Listener window in LOGO (b) Used to exit LOGO

3. BYE primitive (c) The area where the commands are typed

4. Random command (d) The area where the turtle moves and draws

Answer the Following

	 1.	 What is LOGO? Who developed LOGO and when?
	 2.	 Label the following LOGO window.

	 3.	 What are LOGO primitives? Explain any four LOGO primitives to draw shapes.
	 4.	 Write a procedure using RanDom command in LOGO.

Suggested Activities
	 1.	 Write a procedure to draw an equilateral triangle.
	 2.	 Write a procedure to include a random number generator e.g., throwing a die.
	 3.	 Use Full version of LOGO language.



Glossary

134	  	 Information Communication Technology — Grade 9 Student Textbook

Glossary

A

	 AI (Artificial Intelligence): It is the branch of 
computer science concerned with making computers 
behave like humans.
	 Analog: It is any fluctuating, evolving, or 
continually changing process that represents data by 
measurement of a continuous physical variable. 
	 Application Software: A program that is designed 
to perform specific tasks.
	 ASCII: American Standard Code for Information 
Interchange. It is pronounced (as-kee).

B

	 Backup: To copy files or data to a second source or 
media so as to safeguard it. 
	 BCD: Binary Coded Decimal.
	 Bit (Binary DigIT): It is the smallest unit of 
processing of computerized data in terms of 1s or 0s.
	 Browser: Software program that allows the user to 
find and read encoded information in a form suitable 
for display especially on World Wide Web. 
	 Byte: A combination of 8 bits to represent computer 
data transfer or data storage measurement. 

C
	 CD-ROM (Compact Disc Read-Only Memory): 
A durable and low cost circular optical storage device 
widely used to store large amounts of information.
	 Computer: A computer is an electronic device that 
accepts, processes, stores and outputs data under the 
control of a set of instructions.
	 CPU (Central Processing Unit): A processor on 
an IC chip (called a microprocessor) that serves as the 
‘brain’ of the computer. 

D
	 Data: A collection of raw facts and figures or a 
raw input which when processed or arranged makes 
meaningful output.

	 Data Communications: The moving or sharing 
of encoded information between two or more data 
sources using an electronic medium.
	 Distribution List: Also called a mailing list, is a 
collection of e-mail addresses that allows you to e-mail 
multiple people at one time.
	 DVD: Digital Versatile Disc or Digital Video Disc.

E
	 E-Commerce: Buying and selling or business 
transaction conducted on the Internet.
	 E-Mail: Stands for Electronic Mail. This is a system 
of relaying messages across the Internet, from one 
Internet user to another.

F
	 Format Painter: Helps to copy the format that has 
been applied to text and apply it to another.
	 FTP (File Transfer Protocol): A software protocol 
for exchanging information between computers over a 
network.

G

	 Gigabyte (GB): 2 to the 30th power (1,073,741,824) 
bytes. One gigabyte is equal to 1,024 megabytes. 
	 GIGO: It is an acronym that stands for Garbage In, 
Garbage Out.

H
	 Hardware: The physical equipment used in a 
computer system, such as the CPU, peripheral devices 
and memory.
	 Home Page: The initial page of a site on the World 
Wide Web.
	 HTML (Hypertext Markup Language): It is a 
collection of structuring and formatting tags used to 
create Web pages.
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	 HTTP (Hyper Text Transport Protocol): The 
standard protocol for transferring hypertext documents 
on the World Wide Web. 
	 Hypertext: A method of storing data through a 
computer program that allows a user to create and 
link fields of information at will and to retrieve the 
data non-sequentially.

I
	 Icon: A picture or symbol to represent a command 
on a computer screen.
	 IDE (Integrated Development Environment): 
A programming environment integrated into an 
application.
	 IT (Information Technology): The development, 
implementation, and maintenance of computer 
hardware and software systems to organize and 
communicate information electronically.
	 Internet: The Internet is a network of networks 
all of which use the same set of communications 
protocols. 
	 ISP (Internet Service Provider): A company that 
provides access to the Internet.

J
	 JAVA: A high-level programming language 
developed by Sun Microsystems.

K
	 Kilobyte (KB): This is about a thousand bytes of 
space. In reality, it is two to the 10th power or 1,024 
bytes.

L
	 LAN (Local Area Network): A network that 
links together computers and peripheral equipment 
within a limited area, such as a building or a group of 
buildings.
	 Language Processor: Software that converts a 
high level language or assembly language code into 
machine understandable form.
	 Login: To attach to a computer using the user’s 
ID.
	 LOGO (Logic Oriented, Graphics Oriented): 
A high level programming language specifically 
designed for its ease of use and graphics capabilities. 

M
	 Mainframe: Second largest computer available 
after the supercomputer.

	 Megabyte (MB): About a million bytes of space. 
Actually it is 2 raised to the 20th power or 1,048,576 
bytes of space.
	 Memory: Internal storage areas in the computer.
	 MODEM: Stands for MOdulator and DEModulator. 
It is a device that changes data from digital (computer 
language) to analog (phone line language) and then 
back again.
	 Motherboard: The main circuit board of a 
microcomputer.
	 MPEG (Motion Picture Experts Group): A format 
to make, view, and transfer both digital audio and 
digital video files.
	 MS-Excel: Spreadsheet application software, 
provided by Microsoft.
	 MS-PowerPoint: Presentation software, provided 
by Microsoft.
	 MS-Word: Word processing application software, 
provided by Microsoft.

N
	 Netiquette: The rules of etiquette that apply when 
communicating over computer networks, especially 
the Internet. 
	 Network: A system containing any combination 
of computers and its peripherals, used to transmit or 
receive information.

O

	 Operating System: A system software program 
that works as a bridge between computer hardware 
and the user. Operating systems perform basic tasks, 
such as recognizing input from the keyboard, sending 
output to the display screen, keeping track of files 
and directories on the disk, and controlling peripheral 
devices such as disk drives and printers. 
	 Output Device: A device that translates information 
processed by the computer into a form that humans 
can understand.

P

	 Pen Drive: A secondary storage device that can be 
used to easily transfer files between USB-compatible 
systems.
	 Plotter: A computer output device that draws 
images on paper using a pen.
	 Primitives: The LOGO commands are known as 
‘Primitives’.
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Q
	 Query: Used to retrieve information on a certain 
condition from a database.

R
	 RAM (Random Access Memory): A volatile 
computer memory available to the user for the 
temporary storage and manipulation of data. 
	 Relative Reference: The default reference in a 
spreadsheet package.
	 ROM (Read-Only Memory): A memory in which 
program instructions, operating procedures, or other 
data are permanently stored, generally on electronic 
chips during manufacture, and that ordinarily cannot 
be changed by the user or when power is switched 
off.

S

	 Scroll Bar: A widget found in graphical user 
interface and used to show and control which portion 
of a document is currently visible in a window. A 
window may have a horizontal or, vertical scroll bar, 
or both.
	 Server: This is a mainframe computer that serves 
the other computers attached to it.
	 Sheet Tab: In spreadsheet applications, this refers 
to a tab at the bottom of a worksheet that acts as a 
means to identify or access different sheets within a 
workbook.
	 Slide Show: Used to display the slides in a desired 
sequence.
	 Source Code: Program code written in a computer 
language.
	 Software: The set of instructions used to direct 
the operation of a computer, as well a documentation 
giving instructions on how to use them.
	 Spreadsheet: A document which helps to organize 
data in rows and columns that intersect to form cells.
	 System: A combination of the hardware, 
software, and firmware. A system typically consists 
of components (or elements) which are connected 
together in order to accomplish a specific function or 
set of functions.
	 System Software: It is a set of master programs 
that keeps the computer system working. 

T
	 Task bar: The bar that contains the start button 
and appears by default at the bottom of the desktop.

	 Terabyte (TB): 2 to the 40th power 
(1,099,511,627,776) bytes.
	 Trojan: A type of computer virus that is loaded 
into an unsuspecting users system via a host program 
such as a free game.
	 Turtle: A triangular shape pointer used in LOGO 
that helps in drawing figures.

U
	 UNICODE: Binary coding scheme that uses 2 
bytes (16 bits) for each character. It allows almost all 
the written languages of the world to be represented 
using a single character set.
	 UPS (Uninterruptible Power Supply): It is a 
backup power unit that provides continuous power 
when the normal power supply is interrupted.
	 Utility Program: A program developed to run 
within an Operating System to perform a specific 
service.

V
	 Virus: A program or piece of code that is loaded 
onto your computer without your knowledge and 
runs against your wishes.

W
	 WAN (Wide Area Network): A network in 
which computers are connected to each other over 
a long distance, using telephone lines and satellite 
communications.
	 Web page: A single, usually hypertext document 
on the World Wide Web that can incorporate text, 
graphics, sounds, etc.
	 Web server: A computer that runs specific software 
to serve web pages to the Internet.
	 Word Processor: Software that processes textual 
matter and creates organized documents.
	 WWW (World Wide Web): Series of servers or 
computers that are interconnected through hypertext.
	 WYSIWYG: What You Say Is What You Get.

X
	 XML (eXtensible Markup Language): It is a 
markup language, not limited to Web documents.

Z
	 Zip Disks: The disks with a special high-quality 
magnetic coating that have a capacity of 100, 250 or 
750 megabytes.


	Page 1
	Page 2

